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Introduction to the Stateflow
Product

This chapter describes the basics of Stateflow event-based modeling software and its
components.

» “Stateflow Product Description” on page 1-2

» “Use Stateflow to Model Finite State Machines” on page 1-3

* “Construct and Execute a Stateflow Chart” on page 1-11

* “Define Chart Behavior by Using Actions” on page 1-19

* “Create a Hierarchy to Manage System Complexity” on page 1-25

* “Model Synchronous Subsystems by Using Parallelism” on page 1-32
* “Synchronize Parallel States by Broadcasting Events” on page 1-37

* “Monitor Chart Activity by Using Active State Data” on page 1-45

* “Schedule Chart Actions by Using Temporal Logic” on page 1-56

+ “Installing Stateflow Software” on page 1-66
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Introduction to the Stateflow Product

Stateflow Product Description

Model and simulate decision logic using state machines and flow charts

1-2

Stateflow is an environment for modeling and simulating combinatorial and sequential
decision logic based on state machines and flow charts. Stateflow lets you combine
graphical and tabular representations, including state transition diagrams, flow charts,
state transition tables, and truth tables, to model how your system reacts to events, time-
based conditions, and external input signals.

With Stateflow you can design logic for supervisory control, task scheduling, and fault
management applications. Stateflow includes state machines animation and static and
run-time checks for testing design consistency and completeness before implementation.

Key Features

Modeling environment, graphical components, and simulation engine for modeling and
simulating complex logic

Deterministic execution semantics with hierarchy, parallelism, temporal operators, and
events

State diagrams, state transition tables, and state transition matrices representing
finite state machines

MATLAB® and Simulink® representations of periodic and continuous algorithms in
Stateflow charts, truth tables, and flow charts

State diagram animation, state activity and data visualization, and integrated
debugging for analyzing the design and detecting run-time errors

Edit-time and run-time checks for cyclic problems, state inconsistencies, data-range
violations, and overflow conditions

Mealy and Moore finite-state machines



Use Stateflow to Model Finite State Machines

Use Stateflow to Model Finite State Machines

Stateflow is a graphical programing environment based on finite state machines. With
Stateflow, you can test and debug your design, consider different simulation scenarios,
and generate code from your state machine.

Finite state machines are representations of dynamic systems that transition from one
mode of operation (state) to another. State machines:

* Serve as a high-level starting point for a complex software design process.

» Allow you to focus on the operating modes and the conditions required to pass from
one mode to the next mode.

* Help you to design models that remain clear and concise even as the level of
complexity increases.

Control systems design relies heavily on state machines to manage complex logic.
Applications include aircraft, automobile, and robotics control systems.

In a Stateflow chart, you combine states, transitions, and data to implement a finite state
machine. You can also embed MATLAB and Simulink functions inside your chart. You run
a Stateflow chart as a block inside a Simulink model. The Stateflow chart interfaces with
the other blocks in the model by sharing data through input and output connections,
parameters, and data stores.

Example of a Stateflow Chart

This Stateflow chart presents a simplified model of the logic to shift gears in a four-speed
automatic transmission system of a car. The chart represents each gear position by a
state, shown as a rectangle labeled first, second, third, or fourth. Like the gears
they represent, these states are exclusive, so only one is active at a time.

first Weaiiasch, IF ol :
&«
[speed=

“ed=2W (third

[speed<25]

o

The arrow on the left of the diagram represents the default transition and indicates the
first state to become active. When you execute the chart, this state is highlighted on the
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1 Introduction to the Stateflow Product

canvas. The other arrows indicate the possible transitions between the states. To define
the dynamics of the state machine, you associate each transition with a Boolean condition
or a trigger event. For example, this chart monitors the speed of the car and shifts to a
different gear when it crosses some fixed threshold. During simulation, the highlighting in
the chart changes as different states become active.

[speed>10] )
o
[speed<5] speed<25 - [speed<40]
This chart offers a simple design that disregards important factors such as engine speed
and torque. You can construct a more comprehensive and realistic model by linking this
Stateflow chart with other Simulink blocks that represent related automotive
components. The Stateflow example models sf _car and sf _car _using duration
illustrate two possible approaches.
Trigger Transitions with Events
The Stateflow model sf car provides a more complex design for an automatic
transmission system.
L impeller forgue
Ti J
Na 9 i MNe B -
| throttle engine RPM == = i § il >
Engi ] i bl ﬁ i 1 /
ngine ” = = .-
° Mout iﬂi—ii_‘i Tgur output torque
User Inputs — —
Passing Maneuver crae L — ’—' fransmissian —‘
L~ gear transmission speed
_|_ Throttle b
Double-click fo shift_lagic vehicle
open the GUI speed
and select an -
ol p « N
wehicle mph
(yeliow)
& throttle %%
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matlab:openExample('stateflow/AutomaticTransmissionWithActiveStateDataExample')

Use Stateflow to Model Finite State Machines

To open the Stateflow chart, click the arrow in the bottom left corner of the
shift logic block.

-

‘gear_state

- -

+selection_state R
during: [down_th,up_th] = calc_th(gear throttle); -

[speed < down_th]

1
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I

I

I
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I

I

[

fter( TWAIT tick
[speed <= down_th] anerl ick)

S . [speed == up_th]
{send(gear_state.DOVWN)} {send(gear_state.UP)}

Simulink Function
[down_th,up_th] = calc_th(gear.throttle)

e

This chart combines state hierarchy, parallelism, active state data, and event
broadcasting.

* Hierarchy: The state gear state contains a modified version of the chart in the
previous example. Also, the state selection state contains substates that
represent the steady state, upshifting, and downshifting modes of operation. When
circumstances require a shift to a higher or lower gear, these states become active.

* Parallelism: The parallel states gear state and selection state appear as
rectangles with a dashed border. These states operate simultaneously, even as the
substates inside them turn on and off.
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1 Introduction to the Stateflow Product

* Active State Data: The output value gear reflects the choice of gears during
simulation. The chart generates this value from the active substate in gear state.

* Event Broadcasting: In place of Boolean conditions, this chart uses the events UP
and DOWN to trigger the transitions between gears. These events originate from the
send commands in selection state. A trigger event is broadcast when the speed
of the car remains outside the selected gear's range of operation for longer than some
predetermined time. The Simulink function calc_th determines the boundary values
for the range of operation based on the selected gear and the engine speed

(throttle).

Control Flow with State Actions

The Stateflow example sf car using duration is an alternative for modeling the

transmission system in a car.

User Inputs

Impalier torque

L

[Fassing Manauver
brake

throttie >

| theottle

MNa

Enging

gear

L

Gear_|ogic

L0

¥ pear

1iin

Transmission

’—PNOU! i'—iiPi ihout

output
torque

fransmission spesd

‘Wehicla

To open the Stateflow chart, click the arrow in the bottom left corner of the Gear logic

block.
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matlab:openExample('stateflow/AutomaticTransmissionUsingDurationOperatorExample')

Use Stateflow to Model Finite State Machines

rﬂear )
en,du:

[down_threshold,up_threshold] = calculate thresholds(gear,throttle);
up = duration(speed >= up_threshold) > TWAIT;

down = duration(speed <= down_threshold) = TWAIT;

[up] [up] [up]
_[second +———={third +———=fourth
= 2 S
[down] [down] [down]
o J

Simulink Function
[down_th,up th] = calculate thresholds(gear,throttle)

This model places the original chart inside a superstate gear. The superstate monitors
the vehicle and engine speeds and triggers gear changes by using state actions and
temporal logic.

* State Actions: The actions listed on the upper left corner of the state gear determine
the selected gear's operating thresholds and the values of the Boolean conditions up
and down. The label en, du indicates that the state actions are executed when the
state first becomes active (en = entry) and at every subsequent time step while the
state is active (du = during).

+ Temporal Logic: The Boolean conditions up and down use the temporal logic
operator duration to control the transition between gears. The conditions are valid
when the speed of the car remains outside the gear's range of operation for longer
than some predetermined time TWAIT (measured in seconds).

Explore the Examples

In each of the model examples, you can select a brake-to-throttle profile, run a simulation
of the model, and examine the resulting gear selection.

1 To open one of the examples, click sf car orsf car using duration.

1-7


matlab:openExample('stateflow/AutomaticTransmissionWithActiveStateDataExample')
matlab:openExample('stateflow/AutomaticTransmissionUsingDurationOperatorExample')

Introduction to the Stateflow Product

1-8

2

To select a brake-to-throttle profile to simulate, double-click the User Inputs block. In
the Signal Builder dialog box, you can select a predefined profile or create a custom
profile. The default profile is Passing Maneuver.

[ Signal Builder (sf_car/User Inputs) — | *
File Edit Group Signal Axes Help u
SHE| Y M@0 o~ 0B FIREER] > 0 w2
Active Group: | |Passing Maneuver v G| | - | e
1_
Brake
0
-1 1 1 1 1 1 1 1 1 1 ]
99 Throttle
ED_
1 I 1 I 1 I 1 I 1 i
1] 5 10 15 20 25 30 35 40 45 50
Time (sec)
W
Click to select signal ‘
3

To run the simulation, click the Run icon I\-v.

Stateflow provides several ways to examine the results of the simulation, including:

* Chart animation
* Simulink Scope blocks

* Simulation Data Inspector



See Also

4 To observe the chart animation, open the chart and run the simulation. To slow down
the animation speed, select Display > Stateflow Animation > Slow. The chart
animation highlights the active states during the simulation.

5 To open a scope, in the Simulink model, double-click the Scope block. Each scope
displays a graph of its input signals during simulation.

6 To examine your results in the Simulation Data Inspector, click the Simulation Data

Inspector icon ©, The Simulation Data Inspector displays model data such as the
vehicle speed and the gears used during the simulation. To add a data signal to the
Simulation Data Inspector, open the Property Inspector and, under Logging (in
Stateflow) or Logging and accessibility (in Simulink), select the Log signal data
check box.

See Also

Related Examples

. “Implement an Automatic Transmission Gear System by Using the duration
Operator”
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More About

“Construct and Execute a Stateflow Chart” on page 1-11

“Define Chart Behavior by Using Actions” on page 1-19

“Create a Hierarchy to Manage System Complexity” on page 1-25
“Model Synchronous Subsystems by Using Parallelism” on page 1-32
“Synchronize Parallel States by Broadcasting Events” on page 1-37
“Monitor Chart Activity by Using Active State Data” on page 1-45
“Schedule Chart Actions by Using Temporal Logic” on page 1-56



Construct and Execute a Stateflow Chart

Construct and Execute a Stateflow Chart

To implement and test sequential decision logic, create a Stateflow chart and execute it as
a block in a Simulink model. A Stateflow chart is a graphical representation of a finite
state machine and consists of states, transitions, and data. The chart interfaces with other
blocks in a Simulink model by sharing data through input and output connections,
parameters, and data stores. For more information, see “Use Stateflow to Model Finite
State Machines” on page 1-3.

For instance, this Stateflow chart presents the logic underlying a half-wave rectifier. The
chart contains two states labeled On and Off. In the On state, the chart output signal y is
equal to the input x. In the Off state, the output signal is set to zero. The chart
transitions between these states when the input signal crosses some constant threshold
t0. The state action label en, du indicates that the value of y is updated at each time step
of the simulation.

[x>=t0]

Open the Stateflow Editor

1 At the MATLAB command prompt, enter:
sfnew

After a few moments, the Simulink Editor opens a model with an empty Stateflow
chart block.
2 Double-click the chart block. The Stateflow Editor opens. The main components of
the Stateflow Editor are the Chart canvas and the Symbols window.
* In the Chart canvas, you create a chart by adding states, transitions, and other
graphical elements from the object palette on the left of the canvas.

* In the Symbols window, you add new data to the chart and resolve any undefined
or unused symbols.

1-11



1 Introduction to the Stateflow Product

ﬁ Stateflow (chart) untitled/Chart * - Simulink — O X
File Edit View Display Chart Simulation Analysis Code Tools Help

E-o-Ber @8- E-@©¢O®P = (- | > @ -
Chart Symbols g x
® [ urtited » [ chart | @GR E@ ) [T |
@’ TYPE NAME porr @
3
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|

®

i)

¢

[

®

T

(&=
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»

Ready 100% VariableStepAuto
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Add States and Transitions

1

From the object palette, click the State icon = and move the pointer to the
canvas. A state with its default transition appears. To place the state, click a location
on the canvas. At the text prompt, enter the state name and the state action:



Construct and Execute a Stateflow Chart

On
en,du: y=x;

2 Right-click and drag the On state to create another state. Blue graphical cues help
you to align your states horizontally or vertically. The name of the new state changes
to Off. Modify the state action to:

off
en,du: y=0;

3 Realign the two states and pause on the space between the two states. Blue
transition cues indicate several ways in which you can connect the states. To add the
transitions, click on the appropriate cue.

Alternatively, to draw a transition, click and drag from the edge of one state to the
edge of the other state.

4 Double-click each transition and type the appropriate transition condition x<t@ or
x>=1t0. The conditions appear inside square brackets.

5 Clean up the chart:
» To improve clarity, move each transition label to a convenient location above or
below its corresponding transition.

» To align and resize the graphical elements of your chart, select Chart > Arrange
> Arrange Automatically or press Ctrl+Shift+A.

* To resize the chart to fit the canvas, press the space bar or click the Fit To View

icon ] .

Resolve Undefined Symbols

1
In the Symbols window, click the Resolve Undefined Symbols icon @ . The editor

resolves the symbols x and t0 as input data %/, and y as output data “**, based on
their usage in the chart.

1-13
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Symbols A x
G %2 Q=@ )| T
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& @o
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Symbols
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TYPE NAME

&0 0

&) X

by Y

2 Because the threshold t0 does not change during simulation, change it to a

parameter. In the Symbols window, click the Input Data icon % next to t0 and select

l«) Parameter.

3 To set the initial value for the threshold t0, at the MATLAB command prompt, enter:

t0 = 0;

=l

PORT

Alternatively, use the Simulink mask editor to define and initialize t0 as a Simulink

parameter.

4 To determine what data is used in a state or transition, right-click the state or
transition and select Explore. A context menu lists the names and scopes of all
resolved symbols in the state or transition. Selecting a symbol from the context menu

displays its properties in the Model Explorer.

Complete the Model

1 To return to the Simulink Editor, on the explorer bar at the top of the canvas, click

the name of the Simulink model: L&luntitled. If the explorer bar is not visible, click

the Hide/Show Explorer Bar icon @ at the top of the object palette.

2 To add a source to the model:

* From the Simulink Sources library, add a Sine Wave block to the model.
* Double-click the Sine Wave block and set the Sample time to 0.2.
* Connect the output of the Sine Wave block to the input of the Stateflow chart.

* Label the signal as x.

L+




Construct and Execute a Stateflow Chart

To log the input and output signals, right-click each signal and select Log Selected
Signals. Logging a signal allows you to analyze its values in the Simulation Data
Inspector and in the MATLAB workspace after you simulate the model.

Save the Simulink model.

Simulate and Examine the Results

1

To run the simulation, select Simulation > Run or click the Run icon \!".
You can pause or stop the simulation at any time.

. . . . . . [}
To pause simulation, select Simulation > Pause or click the Pause icon =,

. . . . . . [ |
To stop simulation, select Simulation > Stop or click the Stop icon “=.

.

After you simulate the model, the Simulation Data Inspector icon 3 is
highlighted to indicate that it has new simulation data. To open the Simulation Data
Inspector, click the icon. In the Simulation Data Inspector, you can display graphs of
the input and output signals.

1-15
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During simulation, Stateflow saves logged data in a signal logging object Logsout,
which you can access in the MATLAB workspace. For example, at the command
prompt, enter:

logsout
logsout =
Simulink.SimulationData.Dataset

'logsout' with 2 elements

Name BlockPath

1 [1x1 Signal] y rectifier/Chart



See Also

2 [1x1 Signal] X rectifier/Sine Wave

- Use braces { } to access, modify, or add elements using index.

To access the logged elements, use the getElement method. For instance:

A = table(logsout.getElement('x"').Values.Data,
logsout.getElement('y').Values.Data);
A.Properties.VariableNames = {'Input', 'Output'};

A(1:5:end,:)
ans =

11x2 table
Input Output
0 0
4.2074 4.2074
4.5465 4.5465
0.7056 0.7056
-3.784 0
-4.7946 0
-1.3971 0
3.2849 3.2849
4.9468 4.9468
2.0606 2.0606
-2.7201 0

The simulation results show that the rectifier filters out negative input values as desired.

See Also

sfnew

More About

“Use Stateflow to Model Finite State Machines” on page 1-3
“Stateflow Editor Operations”

1-17
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. “Define Chart Behavior by Using Actions” on page 1-19
. “Resolve Undefined Symbols in Your Chart”

. Simulation Data Inspector

. “Access Signal Logging Data”

1-18



Define Chart Behavior by Using Actions

Define Chart Behavior by Using Actions

State and transition actions are instructions that you write inside a state or next to a
transition to define how a Stateflow chart behaves during simulation. For more
information, see “Use Stateflow to Model Finite State Machines” on page 1-3.

For example, the actions in this chart define a state machine that empirically verifies one
instance of the Collatz conjecture. For a given numerical input u, the chart computes the
hailstone sequence n, = u, n;, n,, n3, ... by iterating this rule:

* Ifn;iseven, thenn; ; =n;/2.

* Ifn;is odd, then n;,; = 3n;+1.

The Collatz conjecture states that every positive integer has a hailstone sequence that
eventually reaches a value of one.

@&
| {n=uj}
Init
entry:
[n2==0] | n2=rem(n,2); :
- Lt T
(= y = false: g—={)
exit:

y = isequal(n,1);

Even Odd

entry,during: 5 [n2 == 0] entry,during:
n=n/2; | n=3%{(n-y)+i;
n2 =rem(n.2); J [n2 ~= 0){y = isequal(n,1);} B = (B,

The chart consists of three states. At the start of simulation, the Init state initializes the
chart data:

» The local data n is set to the value of the input u.
* The local data n2 is set to the remainder when n is divided by two.
» The output data y is set to false.
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Depending on the parity of the input, the chart transitions to either the Even or 0dd
state. As the state activity shifts between the Even and 0dd states, the chart computes
the numbers in the hailstone sequence. When the sequence reaches a value of one, the
output data y becomes true and triggers a Stop Simulation block in the Simulink model.

u y STOP
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hailstone

State Action Types

State actions define what a Stateflow chart does while a state is active. The most common
types of state actions are entry, during, and exit actions.

Type of Abbreviation [Description

State Action

entry en Action occurs on a time step when the state becomes
active.

during du Action occurs on a time step when the state is already

active and the chart does not transition out of the state.

exit ex Action occurs on a time step when the chart transitions out
of the state.

You can specify the type of a state action by its complete keyword (entry, during, exit)
or by its abbreviation (en, du, ex). You can also combine state action types by using
commas. For instance, an action with the combined type entry, during occurs on the

time step when the state becomes active and on every subsequent time step while the
state remains active.

This table lists the result of each state action in the hailstone chart.
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n = 3*(n-y)+

n2 = rem(n,2)

State Action Result
Init entry: |When Init becomes active at the start of the simulation,
n2 = rem(n,2determines the parity of n and sets y to false.
y = false;
exit: When transitioning out of Init after one time step,
y = isequal|{determines whether n is equal to one.
Even entry,during{Computes the next number of the hailstone sequence (n /
n =n/2; 2) and updates its parity on:
n2 = rem(n,2);
* The time step when Even first becomes active.
* Every subsequent time step that Even is active.
0dd entry,during{Computes the next number of the hailstone sequence (3n

"+1) and updates its parity on:

* The time step when 0dd first becomes active.
* Every subsequent time step that 0dd is active.
Throughout most of the simulation, y evaluates to zero. On

the last time step, when n = 1, y evaluates to one so this
action does not modify n or n2 before the simulation stops.

Transition Action Types

Transition actions define what a Stateflow chart does when a transition leads away from
an active state. The most common types of transition actions are conditions and
conditional actions. To specify transition actions, use a label with this syntax:

[condition]{conditional action}

condition is a Boolean expression that determines whether the transition occurs. If you
do not specify a condition, an implied condition evaluating to true is assumed.

conditional action is an instruction that executes when the condition guarding the
transition is true. The conditional action takes place after the condition but before any
exit or entry state actions.

This table lists the result of each transition action in the hailstone chart.
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Transition Action Action Type |Result

Default n=u Conditional |At the start of the simulation, assigns the

transition into action input value u to the local data n.

Init

Transition n2 == Condition When n is even, transition occurs. The

from Init to number 1 at the source of this transition

Even indicates that it is evaluated before the
transition to 0dd.

Transition None When n is odd, transition occurs. The

from Init to number 2 at the source of this transition

0dd indicates that it is evaluated after the
transition to Even.

Transition n2 == Condition When n is even, transition occurs.

from 0dd to

Even

Transition n2 ~= 0 Condition When n is odd, transition occurs.

fré)? Evento |"—"iccqual ({Conditional |When transition occurs, determines

0 action whether n is equal to one.

Examine Chart Behavior

Suppose that you want to compute the hailstone sequence starting with a value of nine.

1 In the Model Configuration Parameters dialog box, under Solver, select these

options:

* Start time: 0.0
* Stop time: inf
* Type: Fixed-step

* Fixed-step size: 1

In the Property Inspector, select the symbol n for logging.

In the Constant block, enter an input of u = 9.

Click the Run icon k!/'.

The chart responds with these actions:
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At time t = 0, the default transition to Init occurs.

* The transition action sets the value of n to 9.

* The Init state becomes active.

* The entry actions in Init set n2 to 1 and y to false.

At time t = 1, the condition n2 == 0 is false so the chart prepares to transition to
0dd.

* The exit action in Init sets y to false.

* The Init state becomes inactive.

* The 0dd state becomes active.

* The entry actions in 0dd set n to 28 and n2 to 0.

At time t = 2, the condition n2 == 0 is true so the chart prepares to transition to
Even.

* The 0dd state becomes inactive.

* The Even state becomes active.

* The entry actions in Even set n to 14 and n2 to 0.

At time t = 3, the condition n2 ~= 0 is false so the chart does not take a transition.

+ The Even state remains active.
* The during actions in Even set n to 7 and n2 to 1.
At time t = 4, the condition n2 ~= 0 is true so the chart prepares to transition to 0dd.

* The transition action sets y to false.

* The Even state becomes inactive.

* The 0dd state becomes active.

* The entry actions in 0dd set n to 22 and n2 to 0.

The chart continues to compute the hailstone sequence until it arrives at a value of n
=1 attimet = 19.

At time t = 20, the chart prepares to transition from Even to 0dd.

* Before the Even state becomes inactive, the transition action sets y to true.
* The 0dd state becomes active.
* The entry actions in 0dd do not modify n or n2.
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The Stop Simulation block connected to the output signal y stops the simulation.

Hn

B0 1
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20

e

: —

n 2 3 4 3 6 T 3 g 200 1 12 13 14 15 16 17 18 (R 20.0
See Also
More About
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“Use Stateflow to Model Finite State Machines” on page 1-3

“State Action Types”

“Transition Action Types”

“Synchronize Parallel States by Broadcasting Events” on page 1-37
“Schedule Chart Actions by Using Temporal Logic” on page 1-56



Create a Hierarchy to Manage System Complexity

Create a Hierarchy to Manage System Complexity

Add structure to your model one subcomponent at a time by creating a hierarchy of
nested states. You can then control multiple levels of complexity in your Stateflow chart.
For more information, see “Use Stateflow to Model Finite State Machines” on page 1-3.

State Hierarchy

To create a hierarchy of states, place one or more states within the boundaries of another
state. The inner states are child states (or substates) of the outer state. The outer state is
the parent (or superstate) of the inner states.

Parent ™

-{ Child2

- S/

The contents of a parent state behave like a smaller chart. When a parent state becomes
active, one of its child states also becomes active. When the parent state becomes
inactive, all of its child states become inactive.

Example of Hierarchy
The Stateflow example sf cdplayer models a stereo system consisting of an AM radio,

an FM radio, and a CD player. During simulation, you control the stereo system by
clicking buttons on the CD Player Helper.
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matlab:openExample('stateflow/ModelingACdPlayerradioUsingEnumeratedDataTypeExample')
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u sfcdplayergui EI = @

CD Player Helper GUI

l Insert Disc‘ l Eject Disc J
— CD Reguest
[pay | Crew | [ FF |
— Radio Reguest.
OFF [eo J[Lm | [ am |

The stereo is initially in standby mode (OFF). When you select one of the Radio Request
buttons, the stereo turns on the corresponding subcomponent. If you select the CD player,
you can click one of the CD Request buttons to choose Play, Rewind, Fast-Forward, or
Stop. You can insert or eject a disc at any point during the simulation.

Initially, the complete implementation of this stereo system appears rather complicated.
However, by focusing on a single level of activity at a time, you can design the overall
system design incrementally. For example, these conditions are necessary for the CD
player to enter Fast-Forward play mode:

1  You turned on the stereo.

2 You turned on the CD player.

3 You are playing a disc.

4  You clicked the FF button in the Ul

You can construct a hierarchical model that considers each of these conditions one at a
time. For instance, the outermost level can define the transitions between the stereo
turning on and off. The middle levels define the transition between the different stereo
subcomponents, and between the stop and play modes of the CD player. The bottommost
level defines the response to the CD Request buttons if you have met all the other
conditions for playing a disc.
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To implement the behavior of the stereo system, sf cdplayer uses the hierarchy of
nested states listed by the Model Explorer under the CdPlayerModeManager chart. To
open the Model Explorer, select View > Model Explorer > Model Explorer.

W @ CdPlayerModeManager
v [ ModeManager
(] standby
v [Jon
v [T coMode
W @ Play
(] Normal
] Rew
[ FastForward
[ ] stop
£ AMMode

£ FMMode
[ Eject

This table lists the role of each state in the hierarchy.

Hierarchy Level State Description
Top level (Stateflow chart ModeManager |Normal operating mode for stereo
CdPlayerModeManager) system
Eject Disc ejection mode (interrupts all
other stereo functions)
Stereo system activity (child states |Standby Stereo system is in standby mode
of ModeManager) (OFF)
ON Stereo system is active (ON)
Stereo subcomponents (child AMMode AM radio subcomponent is active
states of On) FMMode FM radio subcomponent is active
CDMode CD player subcomponent is active
CD player activity (child states of |Stop CD player is stopped
CDMode) Play CD player is playing disc
D{sc play modes (child states of Normal Normal play mode
Play)
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Hierarchy Level State Description
Rew Reverse play mode
FastForward |Fast-Forward play mode

This figure shows the complete layout of the states in the chart.

'ﬂudeManagar

tandby
entry:
CumrentRadiohMode = OFF;
MechCmd = STOP;

oM

‘COMode

an:

CurrentRadioMode = CD;
MechCmd = STOP;

e

MechCmd = STOP;

iop
entry: MechCmd = STOP,;

B8 Cdfeg==FLAY

(Play

I
Eject

entry:
MechCmd = EJECT;

‘AMMode

—
FiModa

—_—
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Simplify Chart Appearance by Using Subcharts

You can simplify the overall appearance of a chart with a complex hierarchy by hiding
low-level details inside subcharts, which appear as opaque boxes. The use of subcharts
does not change the behavior of the chart. For instance, in sf cdplayer, the stereo
subcomponents AMMode, FMMode, and CDMode are implemented as subcharts. When you
open the chart CdPlayerModeManager, you see only three levels of the state hierarchy.
To see the details inside one of the subcharts, double-click the subchart.




Create a Hierarchy to Manage System Complexity

ModeManager I — A
\H)
Standby
entry: CurrentRadioMode = OFF;
MechCmd = STOP;
)
[RadioReq == OFF]
[RadioReq != OFF]
(ON )
® r_-g'k:'. \H
(COMode N
[hasChanged(RadioReq)] v [RadioReq==CD]
~rt
2
. v
(AMMode A
X [RadioReg==AM]
\_\T)"'
2
. v
(FMMode h
C *RadioReg==FM"*/
\ J
\ A
- J
[DiscEject]
Eject
enfry:

MechCmd = EJECT:;
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Explore the Example

The example sf _cdplayer contains two other Stateflow charts:
* UserRequest manages the interface with the Ul and passes inputs to the
CdPlayerModeManager chart.

* CdPlayerBehaviorModel receives the output from the CdPlayerModeManager and
mimics the mechanical behavior of the CD player.

Y Y
l—> ]
RR|—& p RadioReq
l:l CurrentRadioMode > I:I

CR l—' CdReq
@) Oy

A 4

t t CJ DiscPresent
DiscEject P DiscEject
MechCmd [—e— I:I
Disclnsert —— DiscPresent > DiscPresent
e/
UserRequest CdPlayerModeManager

CMD CdStatus » I:l
(Y
[ 1

P Disclnsert @Presenl *—p
L )
CdPlayerBehaviorModel

During simulation, you can investigate how each chart responds to interactions with the
CD Player Helper. To switch quickly between charts, use the tabs at the top of the
Stateflow Editor.

DiscPresent
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See Also

See Also

Related Examples

. “Modeling a CD Player/Radio by Using Enumerated Data Types”
. “Modeling a CD Player/Radio Using State Transition Tables”

. “Simulate a Media Player by Using Strings”

More About

. “Use Stateflow to Model Finite State Machines” on page 1-3
. “State Hierarchy”

. “Encapsulate Modal Logic Using Subcharts”

. “Model Media Player by Using Enumerated Data”
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Model Synchronous Subsystems by Using Parallelism
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To implement operating modes that run concurrently, use parallelism in your Stateflow
chart. For example, as part of a complex system design, you can employ parallel states to
model independent components or subsystems that are active simultaneously. For more
information, see “Use Stateflow to Model Finite State Machines” on page 1-3.

State Decomposition

Stateflow charts can combine exclusive (OR) states and parallel (AND) states:

* Exclusive (OR) states represent mutually exclusive modes of operation. No two
exclusive states at the same hierarchical level can be active or execute at the same
time. Stateflow represents each exclusive state by a solid rectangle.

* Parallel (AND) states represent independent modes of operation. Two or more
parallel states can be active at the same time, although they execute in a serial

fashion. Stateflow represents each parallel state by a dashed rectangle with a number
indicating its execution order.

¢
1

pm————————

All states at a given hierarchical level must be of the same type. The parent state, or in
the case of top-level states, the chart itself, has OR (exclusive) or AND (parallel)
decomposition. The default state decomposition type is OR (exclusive). To change the

decomposition type, right-click the parent state and select Decomposition > AND
(Parallel).

Example of Parallel Decomposition

The Stateflow example s _aircontrol employs parallelism to implement an air
controller that maintains air temperature at 120 degrees in a physical plant.


matlab:openExample('stateflow/AirControllerUsingParallelStatesExample')

Model Synchronous Subsystems by Using Parallelism

The controller operates two fans. The first fan turns on when the air temperature rises
above 120 degrees. The second fan provides additional cooling when the air temperature
rises above 150 degrees. The chart models these fans as parallel states FAN1 and FAN2,
both of which are active when the controller is turned on. Except for their operating
thresholds, the fans have an identical configuration of states and transitions that reflects
the two modes of fan operation (On and 0ff).

A third parallel state SpeedValue calculates the value of the output data airflow based
on how many fans have cycled on at each time step. The Boolean expression
in(FAN1.0n) has a value of 1 when the On state of FAN1 is active. Otherwise,
in(FAN1.0n) equals 0. The value of in(FAN2.0n) represents whether FAN2 has cycled
on or off. The sum of these expressions indicates the number of fans that are turned on
during each time step.
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Note To give objects unique identifiers when they have the same name in different parts
of the chart hierarchy, use dot notation such as Fanl.0n and Fan2.0n. For more
information, see “Identify Data by Using Dot Notation”.

This table lists the rationale for using exclusive (OR) and parallel (AND) states in the air

controller chart.

State

Decomposition

Rationale

PowerOff, PowerOn

Exclusive (OR) states

The controller cannot be on and off at the
same time.

FAN1, FAN2

Parallel (AND) states

The fans operate as independent
components that turn on or off depending
on how much cooling is required.

FAN1.0n, FAN1.O0ff

Exclusive (OR) states

Fan 1 cannot be on and off at the same
time.

FAN2.0n, FAN2.0ff

Exclusive (OR) states

Fan 2 cannot be on and off at the same
time.

SpeedValue

Parallel (AND) state

SpeedValue represents an independent
subsystem that monitors the status of the
fans at each time step.

Order of Execution for Parallel States

Although FAN1, FAN2, and SpeedValue are active concurrently, these states execute in
serial fashion during simulation. The numbers in the upper-right corners of the states
specify the order of execution. The rationale for this order of execution is:

* FAN1 executes first because it cycles on at a lower temperature than FAN2. It can turn
on regardless of whether FAN2 is on or off.

* FAN2 executes second because it cycles on at a higher temperature than FAN1. It can
turn on only if FAN1 is already on.

* SpeedValue executes last so it can observe the most up-to-date status of FAN1 and
FAN2.

By default, Stateflow assigns the execution order of parallel states based on their order of
creation in the chart. To change the execution order of a parallel state, right-click the
state and select a value from the Execution Order drop-down list.
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Explore the Example

The Stateflow example contains a Stateflow chart and a Simulink subsystem.

Group 1

i

SWITCH >

CLOCK >

temp » D

L1
wmg;‘ (iﬂow airflow
160 P ambient
Air Controller Ambient Physical Plant
Temperature

Based on the air temperature temp, the Air Controller chart turns on the fans and passes
the value of airflow to the Physical Plant subsystem. This output value determines the

amount of cooling activity, as indicated by this table.

decreases according to the cooling
activity factor.

Value of airflow Description Cooling Activity
Factor k¢,
0 No fans are running. The value of temp |0
does not decrease.
1 One fan is running. The value of temp 0.05
decreases according to the cooling
activity factor.
2 Two fans are running. The value of temp |0.1

The Physical Plant block updates the air temperature inside the plant based on the

equations

temp(0) = Thitiar

templ(t) = (TAmbient - temp(t))'(kHeat - kCool)r
where:
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Thnitia1 1S the initial temperature (default = 70°)

T ambient 1S the ambient temperature (default = 160°)

Kueat is the heat transfer factor for the plant (default = 0.01)
kcool 1S the cooling activity factor corresponding to airflow

The new value of temp determines the amount of cooling at the next time step of the
simulation.

See Also

More About

“Use Stateflow to Model Finite State Machines” on page 1-3

“State Decomposition”

“Execution Order for Parallel States”

“Check State Activity by Using the in Operator”

“Synchronize Parallel States by Broadcasting Events” on page 1-37
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Synchronize Parallel States by Broadcasting Events

Events help parallel states to coordinate with one another, allowing one state to trigger
an action in another state. To synchronize parallel states in the same Stateflow chart,
broadcast events directly from one state to another. For more information on parallel
states, see “Model Synchronous Subsystems by Using Parallelism” on page 1-32.

Broadcasting Local Events

A local event is a nongraphical object that can trigger transitions or actions in a parallel
state of a Stateflow chart. When you broadcast an event to a state, the event takes effect
in the receiving state and in any substates in the hierarchy of that state. To broadcast an
event, use the send operator:

send(event name,state name)

event name is the name of the event to be broadcast. state name is an active state
during the broadcast.

Example of Event Broadcasting

The Stateflow example s security uses local events as part of the design of a home
security system.
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Door Motion 4
Disabled -
[D_mode==1] r‘ﬁctwe . } ﬁ
- after{1/tSample,.sl_call)
[in{Alarm.On.ldle)] X
send(Alert, Alarm);}
! | T
¥ ') ra ",
Active D an / ¥ 1
oor_sens :
- Deb
!r in(Alarm.On.Idie)] . o [ Fheuneing ]
() {send(Aleri Alarm);} [D_made==0] "
2 d
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L
b b + [M_mode==0] [M_mode==1]
Active - -
[Win_sens && .. Disabled
v infAlarm_ Cn.ldle)]
() {send{alertAlarm)} - [W_mode==0]
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h
Alarm /én ~ ‘:
1
| |
[Alarm_active==0] Alert i
=} i
K i
J i
— - !
[Alanm_active==1] after{4/tSample,s|_call}{ i
\ Il_police;} y i
. ;

The security system consists of an alarm and three anti-intrusion sensors (a window
sensor, a door sensor, and a motion detector). After the system detects an intrusion, you
have a small amount of time to disable the alarm. Otherwise, the system calls the police.

The Security System chart models each subsystem with a separate parallel state. An
enabling input signal selects between the On and Of f modes for the alarm, or between
the Active and Disabled modes for each sensor. When enabled, each sensor monitors a
triggering input signal that indicates a possible intrusion.
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Subsystem State Enabling Signal Triggering Signal
Door sensor Door D mode Door_sens
Window sensor Win W _mode Win sens

Motion detector Motion M mode Mot sens

Alarm Alarm Alarm active

If a sensor detects an intrusion while the alarm subsystem is on, then it broadcasts an
Alert event with this command:

send(Alert,Alarm)

To mitigate the effect of sporadic false positives, the motion detector incorporates a
debouncing design, so that only a sustained positive trigger signal produces an alarm. In
contrast, the door and window sensors interpret a single positive trigger signal as an
intrusion and issue an immediate alarm.

In the alarm subsystem, the Alert event causes a transition from the Idle substate to
the Pending substate. When this state becomes active, a warning sound alerts occupants
to the possible intrusion. If there is an accidental alarm, the occupants have a short time
to disable the security system. If not disabled within that time period, the system calls the
police for help.

Coordinate with Other Simulink Blocks

Stateflow charts can use events to communicate with other blocks in a Simulink model.
For instance, in the sf security example:

* The output events Sound and call police drive external blocks that handle the
warning sound and the call to the police. The commands for broadcasting these events
occur in the Alarm. On state:

* The command for Sound occurs as an entry action in the Pending substate.

* The command for call police occurs as an action in the transition between the
Pending and Idle substates.

In each case, the command to issue the output event is the name of the event.

* The input event s1_call controls the timing of the motion detector debouncer and
the short delay before the call to the police. In each instance, the event occurs inside a
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call to the temporal operator after, which results in a transition after the chart

receives the event some number of times.

it}
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Output Events

An output event occurs in a Stateflow chart but is visible in Simulink blocks outside the
chart. This type of event enables a chart to notify other blocks in a model about events

I'd =l_call(] I
D_mode
W_maode
Sound

M_mada
Dioor_sens OD
Win_sens

call_police
Mot_sens
Alarm_active
. v

that occur in the chart.

Each output event maps to an output port on the right side of the chart. Depending on its
configuration, the corresponding signal can control a Triggered Subsystem or a Function-
Call Subsystem. To configure an output event, in the Property Inspector, set the Trigger

Deme of a Stateflow
Home Security System,
including a motion
detector.

¥

]

Latch1 Warning

4’1—»[:1
—

field to one of these options.
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Type of Trigger Description

Either Edge Output event broadcast causes the outgoing signal to toggle
between zero and one.

Function call Output event broadcast causes a Simulink function-call event.

In the sf security example, the output events Sound and call police use edge
triggers to activate a pair of latch subsystems in the Simulink model. When each latch
detects a change of value in its input signal, it briefly outputs a value of one before
returning to an output of zero.

Input Events

An input event occurs in a Simulink block but is visible in a Stateflow chart. This type of
event enables other Simulink blocks, including other Stateflow charts, to notify a specific
chart of events that occur outside it.

An external Simulink block sends an input event through a signal connected to the trigger
port on the top of the Stateflow chart. Depending on its configuration, an input event
results from a change in signal value or through a function call from a Simulink block. To

configure an input event, in the Property Inspector, set the Trigger field to one of these
options.

Type of Trigger Description

Rising Chart is activated when the input signal changes from either zero
or a negative value to a positive value.

Falling Chart is activated when the input signal changes from a positive
value to either zero or a negative value.

Either Chart is activated when the input signal crosses zero as it changes
in either direction.

Function call Chart is activated with a function call from a Simulink block.

In the sf security example, a Simulink Function-Call Generator block controls the

timing of the security system by triggering the input event s1 call through periodic
function calls.

Explore the Example

The Security System chart has inputs from several Manual Switch blocks and outputs to a
pair of latch subsystems that connect to Display blocks. During simulation, you can:
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* Enable the alarm and sensor subsystems and trigger intrusion detections by clicking
the Switch blocks.

* Watch the chart animation highlight the various active states in the chart.
* View the output signals in the Scope block and in the Simulation Data Inspector.

To adjust the timing of the simulation, double-click the Function-Call Generator block and,
in the dialog box, modify the Sample time field. For example, suppose that you set the
sample time to 1 and start the simulation with all subsystems switched on and all sensor
triggers switched off. During the simulation, you perform these actions:

1 Attimet = 250 seconds, you trigger the door sensor. The alarm begins to sound
(Sound = 1) so you immediately disable the alarm system. You switch off the trigger
and turn the alarm back on.

2 Attimet = 520 seconds, you trigger the window sensor and the alarm begins to
sound (Sound = 0). This time, you do not disable the alarm. At around time t = 600,
the security system calls the police (call police = 1). The Sound and
call police signals continue to toggle between zero and one every 80 seconds.

3 Attime t = 1400 seconds, you disable the alarm. The Sound and call police
signals stop toggling.

The Simulation Data Inspector shows the response of the Sound and call police
signals to your actions.
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See Also

Related Examples
. “Modeling a Security System”

More About

. “Model Synchronous Subsystems by Using Parallelism” on page 1-32
. “Activate a Simulink Block by Sending Output Events”

. “Activate a Stateflow Chart by Sending Input Events”

. “Using Triggered Subsystems” (Simulink)

. “Using Function-Call Subsystems” (Simulink)

. “Schedule Chart Actions by Using Temporal Logic” on page 1-56
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Monitor Chart Activity by Using Active State Data

If your Stateflow chart includes data that is highly correlated to the chart hierarchy, you
can simplify your design by using active state data. By enabling active state data, you can:
* Avoid manual data updates reflecting chart activity.

* Log and monitor chart activity in the Simulation Data Inspector.

* Use chart activity data to control other subsystems.

* Export chart activity data to other Simulink blocks.

For more information, see “Create a Hierarchy to Manage System Complexity” on page 1-
25.

Active State Data

Using active state data output can simplify the design of some Stateflow charts. For
example, in this model of a traffic signal, the state that is active determines the value of
the symbol color. When you enable active state data, Stateflow can provide the color of
the traffic signal by tracking state activity. Explicitly updating color is no longer
necessary, so you can delete this symbol and simplify the design of the chart.

Red
en: Sy
color = RED;

after(YELLOWDELAY sec)

Yellow
en:
color = YELLOW: afterfREDDELAY sec)

\—“—J
after(GREENDELAY, sec)

Green
en: L. oy
color = GREEN; b

Stateflow provides active state data through an output port to Simulink or as local data to
your chart. This table lists the different modes of active state data available.
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Activity Mode Data Type Description

Self activity Boolean Is the state active?

Child activity Enumeration Which child state is active?
Leaf state activity Enumeration Which leaf state is active?

To enable active state data, use the Property Inspector.

Select the Create output for monitoring check box.
Select an activity mode from the drop-down list.
Enter the Data name for the active state data symbol.

D W N R

(Optional) For Child or Leaf state activity, enter the Enum name for the active state
data type.

By default, Stateflow reports state activity as output data. To change the scope of an
active state data symbol to local data, use the Symbols window.

Example of Active State Data

The Stateflow example sf traffic light uses active state data to implement the
controller system for a pair of traffic lights.



matlab:openExample('stateflow/ModelingAnIntersectionOfTwo1wayStreetsUsingStateflowExample')

Monitor Chart Activity by Using Active State Data

num_gars signal_state
———»
'a N
- numCars1 Light1
D‘; L] Light
t@ —» Light2
P numCars2 Light2
Safety
N - Assertion

Traffic Controller

num_gars signal_state (<

Inside the Traffic Controller chart, a pair of parallel subcharts manages the logic

Cars1

Cars2

controlling the traffic lights. The subcharts have an identical hierarchy consisting of three
child states: Red, Yellow, and Green. The output data Light1l and Light2 correspond

to the active child states in the subcharts. These signals:

* Determine the phase of the animated traffic lights.

simultaneously green.

Contribute to the number of cars waiting at each light.
Drive a Safety Assertion subsystem verifying that the two traffic lights are never
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To see the subcharts inside the Traffic Controller chart, click the arrow at the bottom left
corner of the chart.

Behavior of Traffic Controller Subcharts
Each traffic controller cycles through its child states, from Red to Green to Yellow and

back to Red. Each state corresponds to a phase in the traffic light cycle. The output
signals Lightl and Light?2 indicate which state is active at any given time.
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(Red ™
®
o
DelayState WaitForlnput
=
[after(REDDELAY, sec)] 1 2
[mumCars = 0] [after(MAXREDDELAY sec)]
¥ y
WaitUntilSafe ToChange
du: greenLightRequested = true;
", J
[after(YELLOWDELAY,sec)] [~greenLightLocked ...
&& after{ REDDELAY sec)|
Yellow
ex:
greenLightLocked = false;
T T
[after(MINGREEMDELAY, sec)... P ; o
&& greenlLightRequested [after(GREENDELAY.sec)]
% 1
Green
en: greenLightLocked = true;
greenLightRequested = false;

Red Light

When the Red state becomes active, the traffic light cycle begins. After a short delay, the
controller checks for cars waiting at the intersection. If it detects at least one car, or if a
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fixed length of time elapses, then the controller requests a green light by setting
greenLightRequest to true. After making the request, the controller remains in the
Red state for a short length of time until it detects that the other traffic signal is red. The
controller then makes the transition to Green.

Green Light

When the Green state becomes active, the controller cancels its green light request by
setting greenLightRequest to false. The controller sets greenLightLocked to
true, preventing the other traffic signal from turning green. After some time, the
controller checks for a green light request from the other controller. If it receives a
request, or if a fixed length of time elapses, then the controller transitions to the Yellow
state.

Yellow Light

Before transitioning to the Red state, the controller remains in the Yellow state for a
fixed amount of time. When the Yellow state becomes inactive, the controller sets
greenLightLocked to false, indicating that the other traffic light can safely turn
green. The traffic light cycle then begins again.

Timing of Traffic Lights
Several parameters define the timing of the traffic light cycle. To change the values of

these parameters, double-click the Traffic Controller chart and enter the new values in
the Block Parameters dialog box.

Parameter Preset Value Description

REDDELAY 6 seconds Length of time before the controller begins
to check for cars at the intersection. Also,
minimum length of time before the traffic
light can turn green after the controller
requests a green light.

MAXREDDELAY 360 seconds Maximum length of time that the controller
checks for cars before requesting a green
light.

GREENDELAY 180 seconds Maximum length of time that the traffic

light remains green.




Monitor Chart Activity by Using Active State Data

Parameter Preset Value Description

MINGREENDELAY 120 seconds Minimum length of time that the traffic
light remains green.

YELLOWDELAY 15 seconds Length of time that the traffic light remains

yellow.

Explore the Example

1 In the Property Inspector, enable logging for these symbols:

* greenLightRequested
* greenLightLocked

* Lightl
+ Light2

Run the simulation.

In the Simulation Data Inspector, display the logged signals in separate axes. The
Boolean signals greenLightRequested and greenLightLocked appear as
numeric values of zero or one. The state activity signals Lightl and Light2 are
shown as enumerated data with values of Green, Yellow, Red, and None.
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B greenLightRequested M Light1
1.0 None
0.8
Red
0.6
04
Yellow
0.2
0# - — Green
0 50 100 150 200 250 300 350 0 50 100 150 200 250 300 350
B greenLightLocked M Light2
10 MNone
0.8
Red
0.6
04
Yellow
0.2
0+ ! ! Green
0 50 100 150 200 250 300 350 0 50 100 150 200 250 300 350

To trace the chart activity during the simulation, you can use the zoom and cursor buttons
in the Simulation Data Inspector. For example, this table details the activity during the
first 300 seconds of the simulation.
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Description

Light

Light2

greenLight
Requested

greenLight
Locked

At the start of the
simulation, both traffic
lights are red.

Red

Red

false

false

After 6 seconds (REDDELAY),
there are cars waiting in
both streets. Both traffic
lights request a green light
by setting
greenLightRequested =
true.

Red

Red

true

false

After another 6 seconds
(REDDELAY):

» Light 1 turns green,
setting
greenLightlLocked =
true and
greenLightRequested
= false.

* Light 2 requests a green
light by setting
greenLightRequested
= true.

Green

Red

false, then
true

true

t =132

After 120 seconds
(MINGREENDELAY), Light 1
turns yellow.

Yellow

Red

true

true
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Time

Description

Light

Light2

greenLight
Requested

greenLight
Locked

t =147

After 15 seconds
(YELLOWDELAY):

* Light 1 turns red, setting
greenLightLocked =
false.

* Light 2 turns green,
setting
greenLightLocked =
true and
greenLightRequested
= false.

Red

Green

false

false, then
true

t =153

After 6 seconds (REDDELAY),
Light 1 requests a green
light by setting
greenLightRequested =
true.

Red

Green

true

true

t =267

Light 2 turns yellow 120
seconds (MINGREENDELAY)
after turning green.

Red

Yellow

true

true

t =282

After 15 seconds
(YELLOWDELAY):

* Light 2 turns red, setting
greenLightlLocked =
false.

* Light 1 turns green,
setting
greenLightLocked =
true and
greenLightRequested
= false.

Green

Red

false

false, then
true




See Also

Light 2 requests a green
light by setting
greenLightRequested =
true.

Time Description Light ([Light2 |greenLight |greenLight
1 Requested |Locked
t = 288 |After 6 seconds (REDDELAY),|Green [Red true true

The cycle repeats until the simulation ends at t = 1000 seconds.

See Also

Related Examples

“Modeling An Intersection Of One-Way Streets Using Stateflow”

More About

“Create a Hierarchy to Manage System Complexity” on page 1-25

“Schedule Chart Actions by Using Temporal Logic” on page 1-56

“Monitor State Activity Through Active State Data”

“Simplify Stateflow Charts by Incorporating Active State Output”

“Check State Activity by Using the in Operator”

“View State Activity by Using the Simulation Data Inspector”
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Schedule Chart Actions by Using Temporal Logic

To define the behavior of a Stateflow chart in terms of simulation time, include temporal
logic operators in the state and transition actions of the chart. Temporal logic operators
are built-in functions that can tell you the length of time that a state remains active or
that a Boolean condition remains true. With temporal logic, you can control the timing of:
» Transitions between states

* Function calls

* Changes in variable values

For more information, see “Define Chart Behavior by Using Actions” on page 1-19.

Temporal Logic Operators

The most common operators for absolute-time temporal logic are after, elapsed, and
duration.

Operator Syntax Description
after after(n, Returns true if n seconds of simulation time have elapsed since
sec) the activation of the associated state. Otherwise, the operator

returns false.

elapsed elapsed(sec) |Returns the number of seconds of simulation time that have
elapsed since the activation of the associated state.
duration duration(C) [Returns the number of seconds of simulation time that have

elapsed since the Boolean condition C becomes true.

1-56

Each operator resets its associated timer to zero every time that:

* The state containing the operator reactivates.
* The source state for the transition containing the operator reactivates.
* The Boolean condition in a duration operator becomes false.

Note Some operators, such as after, support event-based temporal logic and absolute-
time temporal logic in seconds (sec), milliseconds (msec), and microseconds (usec). For
more information, see “Control Chart Execution Using Temporal Logic”.
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Example of Temporal Logic

The Stateflow example s boiler uses temporal logic to model a bang-bang controller
that regulates the internal temperature of a boiler.

A bang-bang temperature control
system for a boiler

a I

LED {OFF=0, RED=1, GREEN=2}
20 P reference LED

temperature D \V BOILER CMD {OFF=0, ON=1} D
>
set point
t D TEMP (deg C)
actual temp

P temp boiler P on/off
digital temp
N B 5 < Boiler
ang-sang Plant model
Controller

The example consists of a Stateflow chart and a Simulink subsystem. The Bang-Bang
Controller chart compares the current boiler temperature to a reference set point and
determines whether to turn on the boiler. The Boiler Plant subsystem models the
dynamics inside the boiler, increasing or decreasing its temperature according to the

status of the controller. The boiler temperature then goes back into the controller chart
for the next step in the simulation.

The Bang-Bang Controller chart uses the temporal logic operator after to:

» Regulate the timing of the bang-bang cycle as the boiler alternates between on and off.

* Control a status LED that flashes at different rates depending on the operating mode
of the boiler.
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The timers defining the behavior of the boiler and LED subsystems operate independently
of one another without blocking or disrupting the simulation of the controller.

Timing of Bang-Bang Cycle

The Bang-Bang Controller chart contains a pair of substates representing the two
operating modes of the boiler: On and 0ff. The graphical function turn_boiler updates
the output data boiler to indicate which one of substates is active.

Heater ?

Off . function turn_boiler(mode)

entry: turn_boiler(QFF)

Flash -
en: flash_LED({) D after(5,sec)

function flash_LED()

after(20,sec) after(40.sec) |
[cold() /

/' [Heater.On.warm()] | [function b = cold()

X
[On

The actions guarding the transitions between the On and Of f substates define the
behavior of the bang-bang controller.

Transition Action Description

From On to Off |after(20,sec) |Transition to the Off state after spending 20
seconds in the On state.

From Off to On |after(40,sec)|When the boiler temperature is below the reference
[cold()] set point (when the graphical function cold ()
returns true), transition to the On state after
spending at least 40 seconds in the Off state.
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Transition Action Description
From On to Off |[Heater.0On.wa|When the boiler temperature is at or above the
rm() 1] reference set point (when the graphical function
Heater.On.warm() returns true), transition to the
Off state.

As a result of these transition actions, the timing of the bang-bang cycle depends on the
current temperature of the boiler. At the start of the simulation, when the boiler is cold,
the controller spends 40 seconds in the Off state and 20 seconds in the On state. At time
t = 478 seconds, the temperature of the boiler reaches the reference point. From that
point on, the boiler has to compensate only for the heat lost while in the Off state. The
controller then spends 40 seconds in the Off state and 4 seconds in the On state.
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B TEMP (deg C) W temperature set point:1
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B BOILER CMD {OFF=0, ON=1}
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Timing of Status LED

The Off state contains a substate Flash with a self-loop transition guarded by the action
after (5, sec). Because of this transition, when the Off state is active, the substate
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executes its entry action and calls the graphical function flash LED every 5 seconds.
The function toggles the value of the output symbol LED between 0 and 1.

?

)

Ooff
entry: turn_boiler{OFF)

Flash —
en: flash_LED() __,D after(5,sec)

T i‘

The On state calls the graphical function flash LED as a state action of type during.
When the On state is active, it calls the function at every time step of the simulation (in
this case, every second), toggling the value of the output symbol LED between 0 and 2.

'On —~ M
en: lurn_boiler(ON) @/J
du: flash_LED()

e

‘. [HIGH [warm()] A{NORM [Heater.On.warm()]
\ M -

function b =warm()

®
ko)

= ~cold()}

\_ /

As a result, the timing of the status LED depends on the operating mode of the boiler. For
example:

* Fromt = 0tot =40 seconds, the boiler is off and the LED signal alternates between 0
and 1 every 5 seconds.
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* Fromt =40 tot = 60 seconds, the boiler is on and the LED signal alternates between
0 and 2 every second.

* Fromt =60 tot = 100 seconds, the boiler is once again off and the LED signal
alternates between 0 and 1 every 5 seconds.

W LED {OFF=0, RED=1, GREEN=2}

7Y} NN S I S S S S—— S N _——

05

0 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95

M BOILER CMD {OFF=0, ON=1}

0.8

06

04

02
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Explore the Example

Use additional temporal logic to investigate how the timing of the bang-bang cycle
changes as the temperature of the boiler approaches the reference set point.

1 Enter new state actions that call the operators elapsed and duration.
* Inthe On state, let Timerl be the length of time that the On state is active:

en,du,ex: Timerl = elapsed(sec)
* Inthe Off state, let Timer2 be the length of time that the boiler temperature is at
or above the reference set point:

en,du,ex: Timer2 = duration(temp>=reference)

The label en, du, ex indicates that these actions take place whenever the
corresponding state is active.

In the Symbols window, click the Resolve Undefined Symbols icon @ . The
Stateflow editor resolves the symbols Timerl and Timer2 as output data 5/,
3 In the Property Inspector, enable logging for these symbols:

* boiler
e Timerl
e Timer2
4  Run the simulation.
In the Simulation Data Inspector, display the signals boiler and Timerl in the same
set of axes. The plot shows that:
* The On phase of the bang-bang cycle typically lasts 20 seconds when the boiler is
cold and 4 seconds when the boiler is warm.

* The first time that the boiler reaches the reference temperature, the cycle is
interrupted prematurely and the controller stays in the On state for only 18
seconds.

*  When the boiler is warm, the first cycle is slightly shorter than the subsequent
cycles, as the controller stays in the On state for only 3 seconds.
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In the Simulation Data Inspector, display the signals boiler and Timer2 in the same
set of axes. The plot shows that:

* Once the boiler is warm, it typically takes 9 seconds to cool in the Off phase of
the bang-bang cycle.

* The first time that the boiler reaches the reference temperature, it takes more
than twice as long to cool (19 seconds).



See Also

M Timer2 M BOILER CMD {OFF=0, ON=1}

A N I N I O M

“Illr

0

50 100 150 200 250 300 350 400 450 500 550 600 650 700 750 800 850 900 950

The shorter cycle and longer cooling time are a consequence of the substate hierarchy
inside the On state. When the boiler reaches the reference temperature for the first time,
the transition from HIGH to NORM keeps the controller on for an extra time step, resulting

in a warmer-than-normal boiler. In later cycles, the history junction ) causes the On
phase to start with an active NORM substate. The controller then turns off immediately
after the boiler reaches the reference temperature, resulting in a cooler boiler.

See Also

Related Examples
. “Bang-Bang Control Using Temporal Logic”

More About

. “Define Chart Behavior by Using Actions” on page 1-19
. “Control Chart Execution Using Temporal Logic”

. “Reuse Logic Patterns by Defining Graphical Functions”
. “History Junctions”
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Installing Stateflow Software

Installation Instructions

Stateflow software runs on Windows® and UNIX® operating systems. Your MATLAB
installation documentation provides all the information you need to install Stateflow
software. Before installing the product, you must obtain and activate a license (see
instructions in your MATLAB installation documentation) and install prerequisite software
(see “Prerequisite Software” on page 1-66 for a complete list).

Prerequisite Software

Before installing Stateflow software, you need the following products:

» MATLAB
* Simulink
* C or C++ compiler supported by the MATLAB technical computing environment

The compiler is required for compiling code generated by Stateflow software for
simulation.

The 64-bit Windows version of the Stateflow product comes with a default C compiler,
LCC-win64. LCC-win64 is used for simulation and acceleration. LCC-win64 is only
used when another compiler has not been configured in MATLAB.

Note The LCC-win64 compiler is not available as a general compiler for use with the
command line MEX in MATLAB. It is a C compiler only, and cannot be used for
SIL/PIL modes.

For platforms other than Microsoft® Windows or to install a different compiler, see
“Set Up Your Own Target Compiler” on page 1-67.

Product Dependencies

For information about product dependencies and requirements, see System
Requirements.
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Set Up Your Own Target Compiler

If you have multiple compilers that MATLAB supports on your system, MATLAB selects
one as your default compiler. You can change the default compiler by calling the mex —
setup command, and following the instructions. For a list of supported compilers, see
www.mathworks.com/support/compilers/current release/.

Note If you are using Microsoft Visual C++® 2010 Professional (or earlier), the
generated C code cannot contain any C structure greater than 2 GB. In a single chart, do
not use data with an aggregate size greater than 2 GB or 400 MB with debugging
enabled.

Using Stateflow Software on a Laptop Computer

If you plan to run the Microsoft Windows version of the Stateflow product on a laptop
computer, you should configure the Windows color palette to use more than 256 colors.
Otherwise, you may experience unacceptably slow performance.

To set the Windows graphics palette:

Click the right mouse button on the Windows desktop to display the desktop menu.

2 Select Properties from the desktop menu to display the Windows Display
Properties dialog box.

3  Select the Settings panel on the Display Properties dialog box.
Choose a setting that is more than 256 colors and click OK.
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The Stateflow Chart You Will Build

To get hands-on experience using Stateflow software, you will build a Stateflow chart in
incremental steps that follow the basic workflow described in “Use C Chart to Model
Event-Driven System”. To give you a context for your development efforts, this chapter
describes the purpose and function of the chart you will build and explains how it
interfaces with a Simulink model. You will also learn how to run a completed version of
the model from the MATLAB command line.

“The Stateflow Chart” on page 2-2

“How the Stateflow Chart Works with the Simulink Model” on page 2-6
“A Look at the Physical Plant” on page 2-7

“Running the Model” on page 2-9



2 The Stateflow Chart You Will Build

The Stateflow Chart

You will build a Stateflow chart that maintains air temperature at 120 degrees in a
physical plant. The Stateflow controller operates two fans. The first fan turns on if the air
temperature rises above 120 degrees and the second fan provides additional cooling if the
air temperature rises above 150 degrees. When completed, your Stateflow chart should
look something like this:

/P oweron ™

-------------------------------------------------------------------

__ k=mp=1a0]

\

b1

' ot
1 temp:=150]
ftermp *=120 [
o

Speed\«’alue

du: airflowy = indFARNT.Om + indFARZ. QR

i’
I
1
1
I
I
1
1
I.

SWITCH SWITCH

P otz rOFF
en:
Airflow=10;

As you can see from the title bar, the chart is called Air Controller and is part of a
Simulink model called sf aircontrol. When you build this chart, you will learn how to
work with the following elements of state-transition charts:
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Exclusive (OR) states. States that represent mutually exclusive modes of operation.
No two exclusive (OR) states can ever be active or execute at the same time. Exclusive
(OR) states are represented graphically by a solid rectangle:

The Air Controller chart contains six exclusive (OR) states:

* PowerOn
* PowerOff
* FAN1.0On
* FAN1.Off
* FAN2.0n
* FAN2.0ff

Parallel (AND) states. States that represent independent modes of operation. Two or
more parallel (AND) states at the same hierarchical level can be active concurrently,
although they execute in a serial fashion. Parallel (AND) states are represented
graphically by a dashed rectangle with a number indicating execution order:

The Air Controller chart contains three parallel (AND) states:

* FAN1
* FAN2
* SpeedValue

Transitions. Graphical objects that link one state to another and specify a direction of
flow. Transitions are represented by unidirectional arrows:
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2-4

The Air Controller chart contains six transitions, from

* PowerOn to PowerQff
* PowerOff to PowerOn
* FAN1.0nto FAN1.Off
* FAN1.0ff to FAN1.0On
* FAN2.0n to FAN2.0ff
* FAN2.0ff to FAN2.0n

Default transitions. Graphical objects that specify which exclusive (OR) state is to be
active when there is ambiguity between two or more exclusive (OR) states at the same
level in the hierarchy. Default transitions are represented by arrows with a closed tail:

|

The Air Controller chart contains default transitions:
* At the chart level, the default transition indicates that the state PowerOff is activated
(wakes up) first when the chart is activated.

* Inthe FAN1 and FAN2 states, the default transitions specify that the fans be powered
off when the states are activated.

State actions. Actions executed based on the status of a state.

The Air Controller chart contains two types of state actions:
* entry (en) action in the PowerOff state. Entry actions are executed when the state is
entered (becomes active).

* during (du) action in the SpeedValue state. During actions are executed for a state
while it is active and no valid transition to another state is available.



The Stateflow Chart

Other types of state actions

There are other types of state actions besides entry and during, but they involve
concepts that go beyond the scope of this guide. For more information, see “Syntax for
States and Transitions”.

Conditions. Boolean expressions that allow a transition to occur when the expression
is true. Conditions appear as labels for the transition, enclosed in square brackets ([ 1).

The Air Controller chart provides conditions on the transitions between FAN1.0n and
FAN1.Off, and between FAN2.0n and FAN2.0ff, based on the air temperature of the
physical plant at each time step.

Events. Objects that can trigger a variety of activities, including:

* Waking up a Stateflow chart

» Causing transitions to occur from one state to another (optionally in conjunction with a
condition)

* Executing actions
The Air Controller chart contains two edge-triggered events:

* CLOCK wakes up the Stateflow chart at each rising or falling edge of a square wave
signal.

* SWITCH allows transitions to occur between PowerOff and PowerOn at each rising or
falling edge of a pulse signal.
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How the Stateflow Chart Works with the Simulink Model

The Stateflow chart you will build appears as a block named Air Controller that is
connected to the model of a physical plant in the Simulink sf aircontrol model. Here
is the top-level view of the model:

2-6

@ SWITCH 1
CLOCEK ]
v
Signal Builder EXid
—» temL:taTlow airflow
temp . I:l
160 | ambient
Scope
Air Cortreller Ambient Fhysical Plant
Temperature

The Simulink model passes the temperature of the plant as an input temp to the Stateflow
Air Controller block. Based on the temperature of the plant, the controller activates zero,
one, or two fans, and passes back to the model an output value airflow that indicates
how fast the air is flowing. The amount of cooling activity depends on the speed of the
fans. As air flows faster, cooling activity increases. The model uses the value of airflow
to simulate the effect of cooling when it computes the air temperature in the plant over
time. You will learn more about these design elements in “Interface with Simulink”.

The Signal Builder block in the Simulink model sends a square wave signal (CLOCK) to
wake up the Stateflow chart at regular intervals and a pulse signal (SWITCH) to cycle the
power on and off for the control system modeled by the Stateflow chart. You will learn
more about these design elements in “Implementing the Triggers” on page 6-2.



A Look at the Physical Plant

A Look at the Physical Plant

o

Simulink software models the plant using a subsystem called Physical Plant, which
contains its own group of Simulink blocks. The subsystem provides a graphical hierarchy
for the blocks that define the behavior of the Simulink model. The inputs, airflow speed
and ambient temperature, model the effects of the controller activity on plant
temperature. Here is a look inside the Physical Plant subsystem:

airfloun

D

]
"
[u]
u] 4 \
4
Corstant 005 -
W
Constantz 04 wli
Constanti MFport
Sitch

x

Product l

1 -
- w1
s G
temp
Integrator
e e

Yy

amibie rit

T Thermal kalation

In this model, the internal temperature of the plant attempts to rise to achieve steady
state with the ambient air temperature, set at a constant 160 degrees (as shown in “How
the Stateflow Chart Works with the Simulink Model” on page 2-6). The rate at which the
internal temperature rises depends in part on the degree of thermal isolation in the plant
and the amount of cooling activity.

Thermal isolation measures how much heat flows into a closed structure, based on
whether the structure is constructed of materials with insulation or conduction
properties. Here, thermal isolation is represented by a Gain block, labeled Thermal
Isolation. The Gain block provides a constant multiplier that is used in calculating the
temperature in the plant over time.

Cooling activity is modeled using a constant multiplier, derived from the value of
airflow, an output from the Stateflow chart. The chart assigns airflow one of three
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cooling factors, each a value that serves as an index into a multiport switch. Using this
index, the multiport switch selects a cooling activity multiplier that is directly
proportional to the cooling factor, as follows:

Cooling Factor What It Means Cooling Activity
(Value of Airflow)
0 No fans are running. The value of temp |0
is not lowered.
1 One fan is running. The value of temp is |-0.05
lowered by the cooling activity multiplier.
2 Two fans are running. The value of temp |-0.1
is lowered by the cooling activity
multiplier.

Over time, the subsystem calculates the cooling effect inside the plant, taking into
account thermal isolation and cooling activity. The cooling effect is the time-derivative of
the temperature and is the input to the Integrator block in the Physical Plant subsystem.
Let the variable temp change represent the time derivative of temperature. Note that
temp change can be a warming or cooling effect, depending on whether it is positive or
negative, based on this equation:

temp_change = ((ambient — temp) = (thermalisolation multiplier)) + ((ambient — temp) * (cooling factor))

The Integrator block computes its output temp from the input temp change, as follows:

t
temp(t) = I temp _ change(t)dt + 70
to

Note In this model, the initial condition of the Integrator block is 70 degrees.

temp is passed back to the Stateflow Air Controller chart to determine how much cooling
is required to maintain the ideal plant temperature.



Running the Model

Running the Model

To see how the sf _aircontrol model works, you can run a completed, tested version,
which includes the Stateflow chart you will build. Here's how to do it:

1 Start MATLAB software.

If you need instructions, consult your MATLAB documentation.
2 Typesf aircontrol at the command line.

This command starts Simulink software and opens the sf aircontrol model:

'Di sf_aircontrol EI@
File Edit View Display Diagram Simulation Analysis Code Tools  Help
-8 2 we-8 d4ob ORGICY » @ @~

sf_aircontrol

®  |[®asf_aircontrol b -
@ SWITCH ,‘:—I
— CLOCK pII
Signal Builder
airflow
temp ]
160 | ambient
Scope
Air Controller Ambient Fhysical Flart
Temperature
b
Ready 100% oded5s

3  Double-click the Air Controller block to open the Stateflow chart.

4 Double-click the Scope block to display the changes in temperature over time as the
model runs.
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Tip Position the Air Controller chart and the Scope window so they are both visible
on your desktop.

5 Start simulation in the Air Controller chart by selecting Simulation > Run.

As the simulation runs, the chart becomes active (wakes up) in the Power0Qff state.
Notice in the Scope that until Power0On becomes active, the temperature rises
unchecked. After approximately 350 seconds into the simulation, a rising edge signal
switches power on and the fans become active.

Note Simulation time can be faster than elapsed time.

When the temperature rises above 120 degrees, FAN1 cycles on. When the
temperature exceeds 150 degrees, FAN2 cycles on to provide additional cooling.
Ultimately, FAN1 succeeds in maintaining the temperature at 120 degrees until a
falling edge signal switches power off again at 500 seconds. Then, the temperature
begins to rise again.

The Scope captures the temperature fluctuations:
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4 Scope

|u
o

(=]

File Tools View Simulation Help

RN O N =R I C R ] R S

Ready T=600.000

Stopping or pausing simulation

You can stop or pause simulation at any time.
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* To stop simulation, select Simulation > Stop.
* To pause simulation, select Simulation > Pause.
6 Close the model.

Where to go next. Now you are ready to start building the Air Controller chart. Begin
at phase 1 of the workflow: “Implementing the Interface with Simulink” on page 3-2.
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In phase 1 of this workflow, you define the interface to the Simulink model.
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Implementing the Interface with Simulink

3-2

In this section...

“Build It Yourself or Use the Supplied Model” on page 3-2
“Design Considerations for Defining the Interface” on page 3-2
“Adding a Stateflow Block to a Simulink Model” on page 3-3
“Defining the Inputs and Outputs” on page 3-8

“Connecting the Stateflow Block to the Simulink Subsystem” on page 3-15

Build It Yourself or Use the Supplied Model

To implement the interface yourself, work through the exercises in this section.
Otherwise, open the supplied model by entering this command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
StagelInterface

Design Considerations for Defining the Interface

The following sections describe the rationale for the input and output of the Stateflow
chart.

Inputs Required from Simulink Model
Type of Input. Temperature of the physical plant

Rationale. The purpose of the chart is to control the air temperature in a physical
plant. The goal is to maintain an ideal temperature of 120 degrees by activating one or
two cooling fans if necessary. The chart must check the plant temperature over time to
determine the amount of cooling required.

Properties of Input. The properties of the temperature input are as follows:

Property Value

Name temp

Scope Input

Size Inherit from Simulink input signal for compatibility
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Property Value
Data type Inherit from Simulink input signal for compatibility
Port 1

Outputs Required from Stateflow Chart
Type of Output. Speed of airflow, based on how many fans are operating

Rationale. When the Simulink subsystem determines the temperature of the physical
plant over time, it needs to account for the speed of the airflow. Airflow speed is directly
related to the amount of cooling activity generated by the fans. As more fans are
activated, cooling activity increases and air flows faster. To convey this information, the
Stateflow chart outputs a value that indicates whether 0, 1, or 2 fans are running. The
Simulink subsystem uses this value as an index into a multiport switch, which outputs a
cooling activity value, as described in “A Look at the Physical Plant” on page 2-7.

Properties of Output. The properties of the airflow output are as follows:

Property Value

Name airflow

Scope Output

Data type 8-bit unsigned integer (uint8)

(The values can be only 0, 1, or 2.)

Port 1

Adding a Stateflow Block to a Simulink Model

To begin building your Stateflow chart, you will add a Stateflow block to a partially built
Simulink model called sf aircontrol exercise, which contains the Physical Plant
subsystem, described in “A Look at the Physical Plant” on page 2-7.

To add a Stateflow block to an existing Simulink model:

1 Open the Simulink model by typing sf aircontrol exercise at the MATLAB
command prompt.

The model opens on your desktop:
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J’i sf_aircontrol_exercise - Simulink prerelease use Elﬂlé]

File Edit View Display Diagram Simulation Analysis Code Tools Help

E-=-8 Be-E-ed®P - - w » @ - g~

sf_aircontrol_exercise |

® sf_airconh'ol_exercise 4 hd
. o
Q This is an incomplete model b
SWITCH > used in the Stateflow Getting Started Guide
EI as the foundation model for building
a Stateflow chart and connecting it to Simulink.
- To see the complete model, type sf_aircontrol

= Guock d Terminstar at the MATLAB command line.

Signal Builder
airfow

D Inport temp » l:l

160 | ambiznt Scope
Ambient -
Temperature Physicsl Flant

» e
Ready 100% oded5

The model is incomplete because it does not include the Stateflow chart that you will
build as you work through the exercises in this guide. Instead, the model contains
several nonfunctional blocks: the Terminator, Inport, and Annotation blocks.

2 Delete the nonfunctional blocks and their connectors.

Tip Hold down the Shift key to select multiple objects, and then press Delete.

Your model should now look like this:
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Py StagelInterface * =3 =R
File Edit View Display Diagram Simulation Analysis Code Tools Help
E FE = T e i
-8 & @2 4® > ORGCY » D - EE -
Stagelinterface
& |"aStagellnterface b hd
S}
SWITCH >
- %
—* CLOCK L
Signal Builder
W irflow
temp ;—l:l
160 | smbient Scope
Ambient o
Temperature Physical Flant
»
Ready 100% oded5

3 Save the model as StagelInterface:

Create a new local folder for storing your working model.

In the Simulink model window, select File > Save As.

Navigate to the new folder.

Enter StagelInterface as the file name.

Leave the default type as Simulink Models.

Click Save.

4  On the toolbar of the Simulink model, click the Library Browser icon:

- 0 Qo N T 9

S]]
Ed

The Simulink Library Browser opens on your desktop:
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ES Simulink Library Browser
File Edit View Help

IE ¥ »| Enter search term - H @l‘

(===

Libraries Library: Stateflow | Search Results: (none) | Freguently Used

Simscape -
. . . . State Transition

Simulink 30D Animation Chart jfﬂ Tahle

Simulink Coder

Simulink Control Design
Simulink Design Optimizatio
Simulink Design Verifier
Simulink Extras

Simulink RealTime

Simulink Support Package
Simulink Support Package
Simulink Support Package -
Simulink Support Package -
Simulink Support Package -
Simulink Support Package -
Simulink Verification and Vi _
Stateflow 3
System Kentification Toolb
Vehicle Network Toolbox  _

LB Truth Table

K

K

oY [e¥ [ [o¥ oY [ [e¥ [o¥ [e¥ oY [o¥ [ [o¥ [=¥ [ [o¥ =¥ [

LI T 3

Showing: Stateflow

5 Add the Stateflow Chart block to the Simulink model:

a In the left scroll pane of the Library Browser, select Stateflow.
b Drag the first block, called Chart, into your model.

The model should now look like this:
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'Pi Stagellnterface * EI@
File Edit View Display Diagram Simulation Analysis Code Tools Help
Cim = () ( bid
(R RO M=IERON (&) ~ s00 » (D~ @ v
Stagelinterface
& |"aStagellnterface b -
S}
SWITCH >
- %
—* CLOCK L
Signal Builder
% W sirflow
) temp N[
Chart 160 - smbiznt Scope
Ambient o
Temperature Physical Flant
»
Ready 100% oded5

6 Click the label Chart under the Stateflow block and rename it Air Controller.

Change the action language of the chart to C:

a
b

0

d

Double-click the block to open the chart.

Right click in an empty area of the chart and select Properties.
From the Action Language box, select C.

Select OK.

Shortcut for adding a Stateflow block to a new Simulink model

At the MATLAB command prompt, enter this command:

sftnew
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A new, untitled Simulink model opens on your desktop, automatically configured with a
Stateflow chart. For more information, see sfnew.

%3 untitied " o s
File Edit View Display Diagram Simulation Analysis Code Tools  Help

FE = I _ 253
%-8 a E=H- 2 4O = ©- 0o @+
Model Browser = untitled
> %] untitled ® |[Pauntitled » -

@)

K]

[Ed ti

= Chart

«
Ready 100% oded5

Defining the Inputs and Outputs

Inputs and outputs are data elements in a Stateflow chart that interact with the parent
Simulink model. To define inputs and outputs for your chart, follow these steps:

1  Double-click the Air Controller block in the Simulink model StagelInterface to
open the Stateflow chart.

The Stateflow Editor opens on your desktop:
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ﬁ Stateflow (chart) untitled/Chart * - Simulink — O X
File Edit View Display Chart Simulation Analysis Code Tools Help

E-o-Ber @8- E-@©¢O®P = (- | > @ -
Chart Symbols g x
® [ urtited » [ chart | @GR E@ ) [T |
@’ TYPE NAME porr @
3

(o

i

“a

|

®

i)

¢

[

®

T

(&=

)

-H

»

Ready 100% VariableStepAuto

2 Add a data element to hold the value of the temperature input from the Simulink
model:

In the editor menu, select Chart > Add Inputs & Outputs > Data Input From

Simulink.

The Data properties dialog box opens on your desktop with the General tab

selected:
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Data data ﬁ
General | Description

Mame: data

Scope: [Input T] Port: [1 i
Size: -1 ["] variable size

Complexity: [[}F’F T]

Type: Inherit: Same as Simulink -

[ Lock data type setting against changes by the fixed-point tools

Unit (e.g., m, m/s~2, N*m): 51, English, ...
inherit

Limit range

Minimurm: Maximum:

Add to Watch Window

[ OK ] ’ Cancel ] ’ HE.‘||:I| AF'F'";"

The default values in the dialog box depend on the scope — in this case, a data
input.
b In the Name field, change the name of the data element to temp.

¢ Leave the following fields at their default values in the General tab because they
meet the design requirements:
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e

Field Default Value What It Means

Scope Input Input from Simulink model. The
data element gets its value from the
Simulink signal on the same input
port.

Size -1 The data element inherits its size
from the Simulink signal on the
same port.

Complexity |Off The data element does not contain
any complex values.

Type Inherit: Same as |The data element inherits its data

Simulink type from the Simulink signal on
the same output port.

Note Ports are assigned to inputs and outputs in the order they are created.
Because temp is the first input you created, it is assigned to input port 1.

In the General tab, select Add to watch window.

The Stateflow Breakpoints and Watch window lets you examine the value of temp
during breakpoints in simulation. You will try this in “Setting Simulation

Parameters and Breakpoints” on page 7-2.

Click OK to apply the changes and close the dialog box.

3 Add a data element to hold the value of the airflow output from the Air Controller
chart:

In the editor menu, select Chart > Add Inputs & Outputs > Data Output To

Simulink.

The Data properties dialog box opens on your desktop, this time with different
default values, associated with the scope Output:
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' Data data ﬁ

General | Logging | Description |

MName: data

Scope: [Dutput T] Port: [1 i

[] Data must resolve to Simulink signal object
Size: [C] variable size

Complexity: [[}ﬁ’ *]

Type: double -

[T Lock data type setting against changes by the fixed-point tools

Unit (e.g., m, m/s"2, N*m): S1, English, ...
inherit
Initial value: [Expressinn -

Limit range

Minimurm: Maximum:

Add to Watch Window

[ oK ] [ Cancel ] [ Help Apply

Note Because airflow is the first output you created, it is assigned to output
port 1.

b In the Name field of the Data properties dialog box, change the name of the data
element to airflow.

¢ In the Type field, select uint8 (8-bit unsigned integer) from the submenu.
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d Look at the Initial value field.

The initial value is a blank expression, which indicates a default value of zero,
based on the data type. This value is consistent with the model design, which
specifies that no fans are running when the chart wakes up for the first time.

e Make the following changes for other properties in the General tab:

Property What to Specify

Limit range Enter 0 for Minimum and 2 for Maximum.

Add to watch Select this to add airflow to the Watch tab of the
window Stateflow Breakpoints and Watch window.

f  Click OK to apply the changes and close the dialog box.

Go back to the Simulink model by clicking the up-arrow button in the Stateflow

Editor toolbar.

Notice that the input temp and output airflow have been added to the Stateflow

block:
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P Stagellnterface * - Simulink prerelease use E@lﬂj

File Edit Wiew Display Diagram Simulation Analysis Code Tools Help
@vrﬁv %E@vv[@%@ﬂb @v &00 »Uv%v
Stage lnterface

® |[PaStageiinterface »

C}
SWITCH ' d
El %
=F CLOCK ' d
Signal Builder -
[
& Emp%irﬂw b b B
I:l temp ————— |:
FY 180 | mbiznt Scor
Ambient =
|E_E| Temperature Physica| Flant -
w L | m 3
Ready 100% oded

Tip You might need to enlarge the Air Controller block to see the input and output
clearly. To change the size of the block:

a Select the block and move your pointer over one of the corners until it changes
to this shape:

"

b  Hold down the left mouse button and drag the block to the desired size.

5 Save StagelInterface.

Tip There are several ways to add data objects to Stateflow charts. You used the

Stateflow Editor, which lets you add data elements to the Stateflow chart that is open and
has focus. However, to add data objects not just to a chart, but anywhere in the Stateflow
design hierarchy, you can use a tool called the Model Explorer. This tool also lets you view
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and modify the data objects you have already added to a chart. For more information, see
“Stateflow Hierarchy of Objects” and “Add Data Through the Model Explorer” in the
Stateflow User's Guide. You can also add data objects programmatically using the
Stateflow API, as described in “Create Stateflow Objects” in the Stateflow API Guide.

Connecting the Stateflow Block to the Simulink Subsystem

Now that you have defined the inputs and outputs for the Stateflow Air Controller block,
you need to connect them to the corresponding signals of the Simulink Physical Plant
subsystem. Follow these steps:

1 Inthe model StagelInterface, connect the output airflow from Air Controller to
the corresponding input in Physical Plant:

a Place your pointer over the output port for airflow on the right side of the Air
Controller block.

The pointer changes in shape to crosshairs.

b  Hold down the left mouse button and move the pointer to the input port for
airflow on the left side of the Physical Plant block.

¢ Release the mouse.

The connection should look something like this:
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9‘& Stagellnterface * - Simulink prerelease use

File

Edit View Display Diagram Simulation Analysis Code Tools Help

b - - e E-RqOP - BN-o Q-
StagelInterface

@

Stage iInterface b

@ SWITCH
CLOCK '
Signal Builder i
arflow
temp —-. I:
180 - smbisnt
‘Air Contraller Seof| |
Ambient =
Temperature Psical Flant -
1| 1 | 3
100% oded5

FrRPEOEE LE S

Tip You can use a shortcut for automatically connecting blocks. Select the source
block, and then hold down the Ctrl key and left-click the destination block.

Connect the output temp from the Physical Plant to the corresponding input in Air
Controller by drawing a branch line from the line that connects temp to the Scope:

Place your pointer on the line where you want the branch line to start.
While holding down the Ctrl key, press and hold down the left mouse button.

Drag your pointer to the input port for temp on the left side of the Air Controller
block.

Release the mouse button and the Ctrl key.
Reposition the connection so that it looks like this:
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P Stagellnterface * - Simulink prerelease use E‘Elﬂ

File Edit View Display Diagram Simulation Analysis Code Tools Help
HE — 7 ddd
5 - - EG B RGP 2 Tw Q|
Stagellnterface
® Siagellnterface » -
@ =
SWITCH »
- @
— CLOCK >
Signal Builder x
El airflow
D temp %E
FPYe—— 180 p| ambient Scop
Ambient T
5] Ternr:Elah.lre Fhys ical Flant
» (4] L] | +
Ready 100% odeds

Tip To reposition connections, move your cursor over the end of the line. When
the cursor changes to a circle, select the end of the line with the left mouse
button and drag the line to a new location.

3 Save StagellInterface.

Where to go next. Now you are ready to model the operating modes with states. See
“Implementing the States to Represent Operating Modes” on page 4-2.
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In phase 2 of this workflow, you define the states for modeling each mode of operation.
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In this section...

“Build It Yourself or Use the Supplied Model” on page 4-2
“Design Considerations for Defining the States” on page 4-2
“Adding the Power On and Power Off States” on page 4-6
“Adding and Configuring Parallel States” on page 4-8

“Adding the On and Off States for the Fans” on page 4-13

Build It Yourself or Use the Supplied Model

To implement the states yourself, work through the exercises in this section. Otherwise,
open the supplied model by entering this command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
Stage2States

Design Considerations for Defining the States

The following sections describe the rationale for the hierarchy and decomposition of
states in the chart.

When to Use States

Whether or not to use states depends on the control logic you want to implement. You can
model two types of control logic: finite state machines and stateless flow charts. Each
type is optimized for different applications, as follows:

Control Logic Optimized for Modeling

Finite state machines |Physical systems that transition between a finite number of
operating modes. In Stateflow charts, you represent each mode
as a state.

Stateless flow charts Abstract logic patterns — such as if, if-else, and case
statements — and iterative loops — such as for, while, and do
loops. You represent these logic constructs with connective
junctions and transitions in Stateflow charts. No states are
required. See “Decision Logic”.
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The Air Controller chart is a system that cools a physical plant by transitioning between
several modes of operation and, therefore, can be modeled as a finite state machine. In
the following sections, you will design the states that model each mode of operation.

Determining the States to Define

States model modes of operation in a physical system. To determine the number and type
of states required for your Air Controller chart, you must identify each mode in which the
system can operate. Often, a table or grid is helpful for analyzing each mode and
determining dependencies between modes.

Analysis of Operating Modes

For Air Controller, the modes of operation are

Operating Mode |Description Dependencies

Power Off Turns off all power in the |No fan can operate when power is off.
control system

Power On Turns on all power in the |Zero, one, or two fans can operate
control system when power is on.

Fan 1 Activates Fan 1 Fan 1 can be active at the same time

as Fan 2. When activated, Fan 1 can
turn on or off.

Fan 1 On Cycles on Fan 1 Fan 1 On can be active if Fan 1 is
active and power is on.
Fan 1 Off Cycles off Fan 1 Fan 1 Off can be active if Fan 1 is

active, and power is on.

Fan 2 Activates Fan 2 Fan 2 can be active at the same time
as Fan 1. When activated, Fan 2 can
turn on or off.

Fan 2 On Cycles on Fan 2 Fan 2 On can be active if Fan 2 is
active and power is on.
Fan 2 Off Cycles off Fan 2 Fan 2 Off can be active if Fan 2 is

active and power is on.
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Operating Mode |Description Dependencies

Calculate airflow Calculates a constant value |Calculates the constant value, based
of 0, 1, or 2 to indicate how |on how many fans have cycled on at
fast air is flowing. Outputs |each time step.

this value to the Simulink
subsystem for selecting a
cooling factor.

Number of States to Define

The number of states depends on the number of operating modes to be represented. In
“Analysis of Operating Modes” on page 4-3, you learned that the Air Controller chart has
nine operating modes. Therefore, you need to define nine states to model each mode.
Here are the names you will assign to the states that represent each operating mode in
“Implementing the States to Represent Operating Modes” on page 4-2:

State Name Operating Mode
PowerOff Power Off
PowerOn Power On

FAN1 Fan 1

FAN2 Fan 2
SpeedValue Calculate airflow
FAN1.On Fan 1 On
FAN1.Off Fan 1 Off
FAN2.0On Fan 2 On
FAN2.0ff Fan 2 Off

Note Notice the use of dot notation to refer to the On and Off states for FAN1 and FAN2.
You use namespace dot notation to give objects unique identifiers when they have the
same name in different parts of the chart hierarchy.

Determining the Hierarchy of States

Stateflow objects can exist in a hierarchy. For example, states can contain other states —
referred to as substates — and, in turn, can be contained by other states — referred to as
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superstates. You need to determine the hierarchical structure of states you will define for
the Air Controller chart. Often, dependencies among states imply a hierarchical
relationship — such as parent to child — between the states.

Based on the dependencies described in “Analysis of Operating Modes” on page 4-3, here
is an analysis of state hierarchy for the Air Controller chart:

Dependent States Implied Hierarchy

FAN1 and FAN2 depend on PowerOn. No FAN1 and FAN2 should be substates of a
fan can operate unless PowerOn is active. |PowerOn state.

FAN1.0On and FAN1.0ff depend on Fanl |FAN1 should have two substates, On and
and Power0On. FAN1 must be active before [O0ff. In this hierarchical relationship, On
it can be cycled on or off. and Off will inherit from FAN1 the
dependency on PowerOn.

FAN2.0n and FAN2.0ff depend on FAN2 |FAN2 should have two substates, On and
and PowerOn. FAN2 must be active before |Off. In this hierarchical relationship, On
it can be cycled on or off. and Off will inherit from FAN2 the
dependency on PowerOn.

The state that calculates airflow needs to | The state that calculates airflow should be a
know how many fans are running at each  |substate of PowerOn so it can check the
time step. status of FAN1 and FAN2 at the same level
of hierarchy.

Determining the Decomposition of States

The decomposition of a state dictates whether its substates execute exclusively of each
other — as exclusive (OR) states — or can be activated at the same time — as parallel
(AND) states. No two exclusive (OR) states can ever be active at the same time, while any
number of parallel (AND) states can be activated concurrently.

The Air Controller chart requires both types of states. Here is a breakdown of the
exclusive (OR) and parallel (AND) states required for the Stateflow chart:

State Decomposition Rationale
PowerOff, Exclusive (OR) The power can never be on and off at the same
PowerOn states time.
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State Decomposition Rationale
FAN1, FAN2 Parallel (AND) Zero, one, or two fans can operate at the same
states time, depending on how much cooling is
required.

FAN1.On, Exclusive (OR) Fan 1 can never be on and off at the same time.
FAN1.Off states

FAN2.On, Exclusive (OR) Fan 2 can never be on and off at the same time.
FAN2.0ff states

SpeedValue Parallel (AND) state |SpeedValue is an observer state that monitors

the status of Fan 1 and Fan 2, updating its
output based on how many fans are operating
at each time step. SpeedValue must be
activated at the same time as Fan 1 and Fan 2,
but execute last so it can capture the most
current status of the fans.

Adding the Power On and Power Off States

When you add states to the Air Controller chart, you will work from the top down in the
Stateflow hierarchy. As you learned in “Determining the Decomposition of States” on page
4-5, the PowerOff and PowerOn states are exclusive (OR) states that turn power off and
on in the control system. These states are never active at the same time. By default,
states are exclusive (OR) states, represented graphically as rectangles with solid borders.

To add Power0On and PowerQff to your chart, follow these steps:

1 Open the model StagelInterface — either the one you created in the previous
exercise or the supplied model for stage 1.

To open the supplied model, enter the following command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs'
StagelInterface

, 'examples'))

Save the model as Stage2States in your local work folder.
In Stage2States, double-click the Air Controller block to open the Stateflow chart.

The Stateflow Editor for Air Controller opens on your desktop. Notice the object
palette on the left side of the editor window. This palette displays a set of tools for
drawing graphical chart objects, including states:
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4  Left-click the state tool icon:
O
5 Move your pointer into the drawing area.

The pointer changes to a rectangle, the graphical representation of a state.
6 Click in the upper-left corner of the drawing area to place the state.

The new state appears with a blinking text cursor in its upper-left corner.
7 At the text cursor, type Power0On to name the state.

Tip If you click away from the text cursor before typing the new name, the cursor
changes to a question mark. Click the question mark to restore the text cursor.

8 Move your pointer to the lower-right corner of the rectangle so it changes to this
symbol:

"

9 Drag the lower-right corner to enlarge the state as shown:

PowerOn ™

- >

10 Click the state tool icon again and draw a smaller state named PowerQff at the
bottom of the drawing area, like this:
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11 Save the chart by selecting File > Save in the Stateflow Editor, but leave the chart
open for the next exercise.

Adding and Configuring Parallel States

In “Determining the States to Define” on page 4-3, you learned that FAN1, FAN2, and
SpeedValue will be represented by parallel (AND) substates of the Power0On state.
Parallel states appear graphically as rectangles with dashed borders.

In this set of exercises, you will learn how to:

* Assign parallel decomposition to Power0n so its substates can be activated
concurrently.

Recall that the decomposition of a state determines whether its substates will be
exclusive or parallel.

* Add parallel substates to a state in the chart.
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Set the order of execution for the parallel substates.

Even though parallel states can be activated concurrently, they execute in a sequential
order.

Setting Parallel Decomposition

Follow these steps:

1

2
3

In the Air Controller chart, right-click inside Power0On.

A submenu opens, presenting tasks you can perform and properties you can set for
the selected state.

In the submenu, select Decomposition > AND (Parallel).
Save the model Stage2States, but leave the chart open for the next exercise.

Adding the Fan States

Follow these steps:

1

Left-click the state tool icon in the Stateflow Editor and place two states inside the
PowerOn state.

Tip Instead of using the state tool icon to add multiple states, you can right-click
inside an existing state and drag a copy to a new position in the chart. This shortcut
is convenient when you need to create states of the same size and shape, such as the
fan states.

Notice the appearance of the states you just added.

The borders of the two states appear as dashed lines, indicating that they are parallel
states. Note also that the substates display numbers in their upper-right corners.
These numbers specify the order of execution. Although multiple parallel (AND)
states in the same chart are activated concurrently, the chart must determine when
to execute each one during simulation.

Name the new substates FAN1 and FAN2.

You have created hierarchy in the Air Controller chart. PowerOn is now a superstate
while FAN1 and FAN2 are substates. Your chart should look something like this:
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PowerOn ™
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|
¥ AN >,

L A

P owerOff

Note Your chart might not show the same execution order for parallel substates
FAN1 and FAN2. The reason is that, by default, Stateflow software orders parallel
states based on order of creation. If you add FAN2 before FAN1 in your chart, FAN2
moves to the top of the order. You will fine-tune order of activation in a later exercise,
“Setting Explicit Ordering of Parallel States” on page 4-11.

Tip If you want to move a state together with its substates — and any other graphical
objects it contains — double-click the state. It turns gray, indicating that the state is
grouped with the objects inside it and that they can be moved as a unit. To ungroup
the objects, double-click the state again.

4 Save the model Stage2States, but leave the chart open for the next exercise.
Adding the SpeedValue State

Recall that SpeedValue acts as an observer state, which monitors the status of the FAN1
and FAN2 states. To add the SpeedValue state, follow these steps:
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1 Add another substate to Power0On under FAN1 and FAN2, either by using the state
tool icon or copying an existing state in the chart.

You might need to resize the substate to prevent overlap with other substates, but
remain within the borders of Power0On.

2 Name the state SpeedValue.

Like FAN1 and FAN2, SpeedValue appears as a parallel substate because its parent,
the superstate Power0On, has parallel decomposition.

Power0n N
AN N FAN2 T \
i
i
b = ‘J.-:: ................. — _J
1 Speedyalue
|
|
A A v
P owerOff

3 Save the model Stage2States, but leave the chart open for the next exercise,
“Setting Explicit Ordering of Parallel States” on page 4-11.

Setting Explicit Ordering of Parallel States
Recall that, by default, Stateflow software assigns execution order of parallel states based

on order of creation in the chart. This behavior is called explicit ordering. In this exercise,
you will set the execution order explicitly for each parallel state in your chart.

4-11



4 Defining the States for Modeling Each Mode of Operation

1 In the Stateflow Editor, select File > Model Properties > Chart Properties.

2 In the Chart properties dialog box, verify that the check box User specified state/
transition execution order is selected and click OK.

Chart: Air Controller ﬁ

General Documentation

Mame:  Air Controller
Machine: (machine) Stage2States

Action Language: [C *]

State Machine Type: [Classic *]

Update method: [Inherited = | Sample Time:

["] Enable C-bit operations

User specified state/transition execution order
Export Chart Level Functions (Make Global)

Use Strong Data Typing with Simulink /O

["] Execute (enter) Chart At Initialization

[T] Initialize Qutputs Every Time Chart Wakes Up

[”] Enable Super Step Semantics

["] Support variable-size arrays

[C] saturate on integer overflow

["] Create data for monitoring: | Child activity

[ Lock Editor

[ Ok ][ Cancel H Help Apply
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Note This option also lets you explicitly specify the order in which transitions
execute when there is a choice of transitions to take from one state to another. This
behavior does not apply to the Air Controller chart because it is deterministic: for
each exclusive (OR) state, there is one and only one transition to a next exclusive
(OR) state. You will learn more about transitions in “Drawing the Transitions Between
States” on page 5-4.

3  Assign order of execution for each parallel state in the Air Controller chart:

a Right-click inside each parallel state to bring up its state properties submenu.
b  From the submenu, select Execution Order and make these assignments:

For State: Assign:
FAN1 1
FAN2 2
SpeedValue 3

Here is the rationale for this order of execution:

* FAN1 should execute first because it cycles on at a lower temperature than
FAN2.

* SpeedValue should execute last so it can observe the most current status of
FAN1 and FAN2.

4 Save the model Stage2States, but leave the chart open for the next exercise,
“Adding the On and Off States for the Fans” on page 4-13.

Adding the On and Off States for the Fans

In this exercise, you will enter the on and off substates for each fan. Because fans cannot
cycle on and off at the same time, these states must be exclusive, not parallel. Even
though FAN1 and FAN2 are parallel states, their decomposition is exclusive (OR) by
default. As a result, any substate that you add to FAN1 or FAN2 will be an exclusive (OR)
state.

Follow these steps:

1 Add two substates inside FAN1 and FAN2.
2 Resize the substates to fit within the borders of FAN1 and FAN2.
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3 In each fan state, name one substate On and name the other Off.

Your Air Controller chart should now look something like this:

PowerOn ™
FANT T N AT )
Cn on
.
rDﬁ_ Drr

P owerOff

4 Save the model Stage2States.

Where to go next. Now you are ready to specify the actions that execute when a state
is active.

4-14



Defining Transitions Between States

2
Define the states 6
for modeling each ShlmuLate
mode of operation the chart
3
1 f 5 7
) Define ;
Define the : Decide how to Debu
’ state actions ; 9
interface and variables trigger the chart the chart
to Simulink

4
Define the

transitions
between states

In phase 4 of this workflow, you define the transitions between states.
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Adding the Transitions

In this section...

“Build It Yourself or Use the Supplied Model” on page 5-2

“Design Considerations for Defining Transitions Between States” on page 5-2
“Drawing the Transitions Between States” on page 5-4

“Adding Default Transitions” on page 5-7

“Adding Conditions to Guard Transitions” on page 5-10

“Adding Events to Guard Transitions” on page 5-11

Build It Yourself or Use the Supplied Model

To add the transitions yourself, work through the exercises in this section. Otherwise,
open the supplied model to see how the transitions should appear in the chart. Enter this
command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
Stage4Transitions

Design Considerations for Defining Transitions Between
States

The following sections describe the decisions you make for defining state transitions.
Deciding How and When to Transition Between Operating Modes

Transitions create paths for the logic flow of a system from one state to another. When a
transition is taken from state A to state B, state A becomes inactive and state B becomes
active.

Transitions have direction and are represented in a Stateflow chart by lines with
arrowheads. Transitions are unidirectional, not bidirectional. You must add a transition
for each direction of flow between two states.

Exclusive (OR) states require transitions. Recall that no two exclusive states can be active
at the same time. Therefore, you need to add transitions to specify when and where
control flows from one exclusive state to another.

5-2



Adding the Transitions

Typically, parallel (AND) states do not require transitions because they execute
concurrently.

The Air Controller chart models a system in which power can cycle on and off and, while
power is on, fans can cycle on and off. Six exclusive (OR) states represent these operating
modes. To model this activity, you need to add the following transitions between exclusive
(OR) states:

* PowerQff to PowerOn

* PowerOn to PowerQff

* FAN1.0ff to FAN1.0n

* FAN1.0nto FAN1.Off

* FAN2.0ff to FAN2.0n

* FAN2.0n to FAN2.0Off

Deciding Where to Place Default Transitions

Good design practice requires that you specify default transitions for exclusive (OR)
states at each level of hierarchy. Default transitions indicate which exclusive (OR) state is
to be active when there is ambiguity between two or more exclusive (OR) states at the
same level in the Stateflow hierarchy. There are three such areas of ambiguity in the Air
Controller chart:

*  When the chart wakes up, should power be on or off?
*  When FAN1 becomes active, should it be on or off?
*  When FAN2 becomes active, should it be on or off?

In each case, the initial state should be off so you will add default transitions to the states
PowerOff, FAN1.0ff, and FAN2.0Off.

Deciding How to Guard the Transitions
Guarding a transition means specifying a condition, action, or event that allows the
transition to be taken from one state to another. Based on the design of the Air Controller

chart, here are the requirements for guarding the transitions from one exclusive
operating mode to another:
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Transition When Should It Occur? How to Guard It
PowerQOff to PowerOn At regular time intervals Specify an edge-triggered
PowerOn to PowerQff S
FAN1.Off to FAN1.0On When the temperature of Specify a condition based on
the physical plant rises temperature value
above 120 degrees
FAN1.0n to FAN1.Off When the temperature of

the physical plant falls
below 120 degrees
FAN2.0ff to FAN2.0n When the temperature rises
above 150 degrees, a
threshold indicating that
first fan is not providing the
required amount of cooling
FAN2.0n to FAN2.0ff When the temperature falls
below 150 degrees

Drawing the Transitions Between States

In “Design Considerations for Defining Transitions Between States” on page 5-2, you
learned that the following transitions occur in the Air Controller chart:

» Power for the control system can cycle on and off.

* Each fan can cycle on and off.

You will model this activity by drawing transitions between the Power0On and PowerOff
states and between the On and Off states for each fan. Follow these steps:

1 Open the model Stage3Actions — either the one you created in the previous
exercises or the supplied model for stage 3.

To open the supplied model, enter the following command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
Stage3Actions

Save the model as Stage4Transitions in your local work folder.

In Staged4Transitions, double-click the Air Controller block to open the Stateflow
chart.
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The chart opens on your desktop.
4 Draw transitions between the PowerOff to PowerOn states:
a Move your pointer over the top edge of PowerOff until the pointer shape
changes to crosshairs.
b  Hold down the left mouse button, drag your pointer to the bottom edge of
PowerOn, and release the mouse.

You should see a transition pointing from PowerQff to Power0On:

PowerCn ™
FANT T N AR T \
| [On On
|
|
I A
I Off ot
i
I
N - T s

! Speedvalua
i during: airflow = in(FAMNT1.0n) + in(FAMZ 0n);
I
i
A 'y w
PowerOf
entry: airflow = 0;

¢ Follow the same procedure to draw a transition from PowerQOn to PowerOff.

Your chart should now look like this:
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(PowerOn ™
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! Speedvalua
i during: airflow = in(FAMNT1.0n) + in(FAMZ 0n);
I
i
M ' A
PowerOff
entry: airflow = 0;

Follow the procedure described in step 3 to draw the following transitions between
the Off and On states for each fan:

* Transition from Off to On in FAN1

* Transition from On to Off in FAN1

* Transition from Off to On in FAN2

* Transition from On to Off in FAN2

Your chart should now look like this:
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PowerOn N

\ o J A% e/
I SpeedValue
y during: airflow = in(FAN1.0n) + infFANZ On);

|
|
- '~ v

[

entry: airflow = ;

6 Save Staged4Transitions, but leave the chart open for the next exercise.

Adding Default Transitions

In “Deciding Where to Place Default Transitions” on page 5-3, you learned that you need
to add default transitions to PowerOff, FAN1.0ff, and FAN2.Off. Follow these steps:

1 In the Stateflow Editor, left-click the default transition icon in the object palette:

“a

2  Move your pointer into the drawing area.

The pointer changes to a diagonal arrow.
3  Place your pointer at the left edge of the PowerOff state.
4  When the arrow becomes orthogonal to the edge, release the mouse button.

The default transition attaches to the PowerOQff state. It appears as a directed line
with an arrow at its head and a closed tail:
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PowerOn )

"FAN1
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| SpeedValue
y during: airflow = in(FAN1.0n) + infFANZ On);

i
i
i
- ' v

PowerOff
entry: airflow = ;

5 Repeat the same procedure to add default transitions at the top edges of FAN1.0ff
and FAN2.0ff.

Your chart should now look like this:
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PowerOn )
FaNd T VA T )
on on

\m _J_ l‘*—-—-—-——-——-——-—_——-)
| SpeedValue
y during: airflow = in(FAN1.0n) + infFANZ On);

i
i
i
- ' v

PowerOff
entry: airflow = ;

Tip The location of the tail of a default transition determines the state it activates.
Therefore, make sure that your default transition fits completely inside the parent of
the state that it activates. In the Air Controller chart pictured above, notice that the
default transition for FAN1.Off correctly resides inside the parent state, FAN1. Now
consider this chart:
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PowerOn ™

A

In this example, the tail of the default transition resides in Power0n, not in FAN1.
Therefore, it will activate FAN1 instead of FAN1.Off.

6 Save Staged4Transitions, but leave the chart open for the next exercise.

Adding Conditions to Guard Transitions

Conditions are expressions enclosed in square brackets that evaluate to true or false.
When the condition is true, the transition is taken to the destination state; when the
condition is false, the transition is not taken and the state of origin remains active.

As you learned in “Deciding How to Guard the Transitions” on page 5-3, the fans cycle on
and off depending on the air temperature. In this exercise, you will add conditions to the
transitions in FAN1 and FAN2 that model this behavior.

Follow these steps:
1 Click the transition from FAN1.Off to FAN1.On.

The transition appears highlighted and displays a question mark (?).
Click next to the question mark to display a blinking text cursor.
3 Type the following expression:

[temp >= 120]

You may need to reposition the condition for readability. Click outside the condition,
then left-click and drag the condition expression to a new location.



Adding the Transitions

4 Repeat these steps to add the following conditions to the other transitions in FAN1
and FAN2:

Transition Condition
FAN1.0On to FAN1.Off [temp < 120]
FAN2.0ff to FAN2.0n [temp >= 150]
FAN2.0n to FAN2.0ff [temp < 150]

Your chart should look like this:

PowerOn ™

i (On [temp=120] on [temp=150]
! N >
i
i
i [temp==12 [temp==1

PowerOff
entry: airflow = 0;

5 Save Staged4Transitions, but leave the chart open for the next exercise.

Adding Events to Guard Transitions

Events are nongraphical objects that trigger activities during the execution of a Stateflow
chart. Depending on where and how you define events, they can trigger a transition to
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occur, an action to be executed, and state status to be evaluated. In this exercise, you will
define an event that triggers transitions.

As you learned in “Deciding How to Guard the Transitions” on page 5-3, the control
system should power on and off at regular intervals. You model this behavior by first
defining an event that occurs at the rising or falling edge of an input signal, and then
associating that event with the transitions between the PowerOn and PowerQff states.

Follow these steps to define an edge-triggered event and associate it with the transitions:

1 In the Stateflow Editor, add an input event by selecting Chart > Add Inputs &
Outputs > Event Input From Simulink.

The Event properties dialog box opens on your desktop:
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"l Event event

[l

Mame: event

Scope: |Input from Simulink *] Fort: Trigger:

Debugger breakpoints: [ Start of Broadcast End of Broadcast

Description:

Document link:

Ok ][ Cancel ” Help Apply

Note that the event is assigned to trigger port 1.

Edit the following properties:

Property What to Specify

Name Change the name to SWITCH.

Trigger Select Either from the drop-down menu so the event can be
triggered by either the rising edge or falling edge of a signal.

Click OK to record the changes and close the dialog box.

Look back at the model and notice that a trigger port appears at the top of the

Stateflow block:
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When you define one or more input events for a chart, Stateflow software adds a
single trigger port to the block. External Simulink blocks can trigger the input events
via a signal or vector of signals connected to the trigger port.

5 Back in the Stateflow Editor, associate the input event SWITCH with the transitions:

a  Select the transition from PowerOff to PowerOn and click the question mark to
get a text cursor.

b  Type the name of the event you just defined, SWITCH.

You might need to reposition the event text for readability. If so, click outside the
text, left-click the text, and drag it to the desired location.
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¢ Repeat these steps to add the same event, SWITCH, to the transition from
PowerOn to PowerOff.

Your chart should now look something like this:

PowerOn ™

- =, =

{FAMN v CEAND 5

! On [temp=120] on [temp=150]
J | [ _
[temp=¥ﬂ]ﬁ ] [temp==1
L

_ \, '
| SpeedValue X
i during: airflow = infFAMN1.0n) + infFAMNZ On};
I
I
S Iy )
SV ITGHT lE ITCH
PowerOff

entry: airflow = ;

Now that you have associated these transitions with the event SWITCH, the control
system will alternately power on and off every time SWITCH occurs — that is, every
time the chart detects a rising or falling signal edge.

Note that the sf _aircontrol model has already defined the pulse signal SWITCH in
the Signal Builder block at the top level of the model hierarchy:
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SWITCH

¥

=

CLOCK

h 4

Signal Builder

In the next phase of the workflow, you will connect your Stateflow chart to the
SWITCH signal to trigger the transitions between power on and power off.

6 Save Staged4Transitions.

Where to go next. Now you are ready to implement an edge-triggered event to wake
up the chart at regular intervals. See “Implementing the Triggers” on page 6-2.
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In phase 5 of this workflow, you decide how to trigger the chart.
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Implementing the Triggers

6-2

In this section...

“Build It Yourself or Use the Supplied Model” on page 6-2
“Design Considerations for Triggering Stateflow Charts” on page 6-2
“Defining the CLOCK Event” on page 6-3

“Connecting the Edge-Triggered Events to the Input Signals” on page 6-4

Build It Yourself or Use the Supplied Model

To implement the triggers yourself, work through the exercises in this section. Otherwise,
open the supplied model to see how the triggers should appear in the chart. Enter this
command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
Stage5Trigger

Design Considerations for Triggering Stateflow Charts

A Simulink model can wake up a Stateflow chart by

* Sampling the chart at a specified or inherited rate
* Using a signal as a trigger
* Using one Stateflow chart to drive the activity of another

A signal trigger works best for the Air Controller chart because it needs to monitor the
temperature of the physical plant at regular intervals. To meet this requirement, you will
use a periodic signal to trigger the chart. The source is a square wave signal called
CLOCK, provided by a Signal Builder block in the Simulink model, described in “How the
Stateflow Chart Works with the Simulink Model” on page 2-6. To harness the signal, you
will set up an edge trigger event that wakes the chart at the rising or falling edge of
CLOCK.

The rationale for using an edge trigger in this case is that it uses the regularity and
frequency of the signal to wake up the chart. When using edge triggers, keep in mind that
there can be a delay from the time the trigger occurs to the time the chart begins
executing. This is because an edge trigger causes the chart to execute at the beginning of
the next simulation time step, regardless of when the edge trigger actually occurred
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during the previous time step. The Air Controller can tolerate this delay, as long as the
edge occurs frequently enough. (For more information about triggering Stateflow charts,
see “Implement Interfaces to Simulink Models” in the Stateflow User's Guide.)

Recall that you already defined one edge-triggered event, SWITCH, to guard the
transitions between PowerQff and Power0On. You will now define a second edge-
triggered event, CLOCK, to wake up the chart.

Defining the CLOCK Event

To define the CLOCK event, follow these steps:

1

Open the model Staged4Transitions — either the one you created in the previous
exercises or the supplied model for stage 4.

To open the supplied model, enter the following command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
Staged4Transitions

Save the model as Stage5Trigger in your local work folder.
In Stage5Trigger, double-click the Air Controller block to open the Stateflow chart.

In the Stateflow Editor, add an input event by selecting Chart > Add Inputs &
Outputs > Event Input From Simulink.

In the Event properties dialog box, edit the following fields:

Property What to Specify

Name Change the name to CLOCK.

Trigger Select Either from the drop-down menu so that the rising or
falling edge of a signal can trigger the event.

Because the SWITCH event you created in “Adding Events to Guard Transitions” on
page 5-11 was assigned to trigger port 1, the CLOCK event is assigned to trigger port
2. Nevertheless, only one trigger port appears at the top of the Air Controller block to
receive trigger signals. This means that each signal must be indexed into an array, as
described in “Connecting the Edge-Triggered Events to the Input Signals” on page 6-
4.

Click OK to record the changes and close the dialog box.
Save Stage5Trigger, but leave it open for the next exercise.

6-3



6 Triggering a Stateflow Chart

6-4

Connecting the Edge-Triggered Events to the Input Signals

You need to connect the edge-triggered events to the Simulink input signals in a way that

» Associates each event with the correct signal

* Indexes each signal into an array that can be received by the Air Controller trigger
port

In Stage5Trigger, notice that the two input signals SWITCH and CLOCK feed into a Mux
block where they are joined in an array to a single output. SWITCH is a pulse signal and
CLOCK is a square wave. When you connect the Mux to the trigger port, the index of the
signals in the array are associated with the like-numbered ports. Therefore, the SWITCH
signal at the top input port of the Mux triggers the event SWITCH on trigger port 1.
Likewise, the CLOCK signal at the second input port of the Mux triggers the event CLOCK
on trigger port 2.

To connect the Mux to the trigger port, follow these steps:
1 (Click the Mux block, hold down the Ctrl key, and click the Air Controller block.

The output signal of the Mux block connects to the input trigger port of the Stateflow
block. Your model should look like this:



Implementing the Triggers

"i StageSTrigger * - Simulink

File Edit View Display Diagram Simulation Analysis Code Tools Help
— ‘/'_'\ —

B -=-8 @ -E-Red®P N > @@
StageSTrigger
® Siﬁgeﬁrigger [ hd
&

SWITCH -
- %
= CLOCK -
Signal Builder
airflow
l:‘ temp -‘rl:l
[-E Air Contraller 1% i Scape

Ambient -

|E_E| Temperature Physical Plant
b
Ready 100% oded5

2 Save Stage5Trigger.

Where to go next.

Now you are ready to simulate your chart. See “Setting Simulation

Parameters and Breakpoints” on page 7-2.
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In phase 6 of this workflow, you simulate the chart to test its behavior. During simulation,
you can animate Stateflow charts to highlight states and transitions as they execute.
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Setting Simulation Parameters and Breakpoints

7-2

In this section...

“Prepare the Chart Yourself or Use the Supplied Model” on page 7-2
“Checking That Your Chart Conforms to Best Practices” on page 7-2
“Setting the Length of the Simulation” on page 7-3

“Configuring Animation for the Chart” on page 7-4

“Setting Breakpoints to Observe Chart Behavior” on page 7-5
“Simulating the Air Controller Chart” on page 7-5

Prepare the Chart Yourself or Use the Supplied Model

To prepare the chart for simulation yourself, work through the exercises in this section.
Otherwise, open the supplied model to see how simulation parameters should appear.
Enter this command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
Stage6Simulate

Checking That Your Chart Conforms to Best Practices

Before starting a simulation session, you should examine your chart to see if it conforms
to recommended design practices:

* A default transition must exist at every level of the Stateflow hierarchy that contains
exclusive (OR) states (has exclusive [OR] decomposition). (See “Deciding Where to
Place Default Transitions” on page 5-3.)

* Whenever possible, input data objects should inherit properties from the associated
Simulink input signal to ensure consistency, minimize data entry, and simplify
maintenance of your model. Recall that in “Defining the Inputs and Outputs” on page
3-8, you defined the input temp to inherit its size and type from the Simulink output
port temp, which provides the input value to the Air Controller chart.

* Output data objects should not inherit types and sizes because the values are back
propagated from Simulink blocks and may, therefore, be unpredictable. Recall that in
“Defining the Inputs and Outputs” on page 3-8, you specified the data type as uint8
and the size as scalar (the default). (See “Avoid inheriting output data properties from
Simulink blocks” in the Stateflow User's Guide.)
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Tip You can specify data types and sizes as expressions in which you call functions that
return property values of other variables already defined in Stateflow, MATLAB, or
Simulink software. Such functions include type and fixdt. For more information, see
“Enter Expressions and Parameters for Data Properties” in the Stateflow User's Guide.

Setting the Length of the Simulation

To specify the length of the simulation, follow these steps:

1

Open the model Stage5Trigger — either the one you created in the previous
exercises or the supplied model for stage 5.

To open the supplied model, enter the following command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
Stage5Trigger

Save the model as Stage6Simulate in your local work folder.
Double-click Air Controller to open the chart.
Check the settings for simulation time:

a In the Stateflow Editor, select Simulation > Model Configuration
Parameters.

The following dialog box opens:
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&% Configuration Parameters: Stage63imulate/Configuration (Active) @Elﬂ
% Commonly Used Parameters | = All Parameters I
Select: Simulation time
Solver Start time: 0.0 Stop time: 600
Data Import/Export
> Optimization Solver options
> Diagnostics
Hardware Implementation Type: |Variable-step '] Solver: ’0de45 (Dormand-Prince) -
Model Referencing
Simulatien Target » Additional options

> Code Generation

m

1 m | »

\3" [ oK H Cancel H Help Apply

b  Click Solver in the left Select pane if it is not already selected.

Under Simulation time on the right, note that the start and stop times have
been preset for you. You can adjust these times later as you become more
familiar with the run-time behavior of the chart.

¢ Keep the preset values for now and click OK to close the dialog box.

5 Leave the chart open for the next exercise.

Configuring Animation for the Chart
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When you simulate a Simulink model, Stateflow animates charts to highlight states and
transitions as they execute. Animation provides visual verification that your chart behaves
as you expect. Animation is enabled by default to Fast. Slowing it down gives you more
time to view the execution order of objects. To configure animation for your simulation
session, follow these steps:

1 Set the speed of animation by selecting Simulation > Stateflow Animation >
Medium. This slows the animation down.

2 Leave the Air Controller chart open for the next exercise.

Setting Breakpoints to Observe Chart Behavior

In this exercise, you will learn how to set breakpoints to pause simulation during key run-
time activities so you can observe the behavior of your chart in slow motion. You will set
the following breakpoints:

Breakpoint Description
Chart Entry Simulation halts when the Stateflow chart wakes up.
State Entry Simulation halts when a state becomes active.

You will also learn how to examine data values when simulation pauses.
Follow these steps:

1 Right click in the chart, and select Set Breakpoint on Chart Entry.

2 For each state PowerOn and PowerOQff, right click in the state, and select Set
Breakpoints > On State Entry.

Simulating the Air Controller Chart

In this exercise, you will simulate the Air Controller chart. During simulation, you will
change breakpoints and observe data values when execution pauses. Follow these steps.

1 In Stage6Simulate, open the Scope block. Position the Scope block and the Air
Controller chart so they are visible on your desktop.

2 Start simulation by selecting Simulation > Run.
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After the simulation target is built, the chart appears with a gray background,
indicating that simulation has begun. Simulation continues until it reaches the first
breakpoint, when the Air Controller chart wakes up.

Right click a transition in the state FAN1, and select Add to watch > (Input) temp.
This adds the variable temp to the Stateflow Breakpoints and Watch window.

Right click in the state SpeedValue, and select Add to watch > (Output) airflow.
This adds the variable airflow to the Stateflow Breakpoints and Watch window.

Tip You can also view data values from the MATLAB command line at simulation
breakpoints. Here's how to do it:

a  When simulation pauses at a breakpoint, click in the MATLAB command line and
press the Enter key.

The MATLAB Command Window displays a debug>> prompt.
b At the prompt, type the name of the data object.

The MATLAB Command Window displays the value of the data object.

View the values of temp and airflow.

Note that temp is 70 (below the threshold for turning on FAN1) and airflowis 0
(indicating that no fans are running).

Resume simulation by clicking the Continue button.

Simulation continues until the next breakpoint, activation of the PowerOff state,
which appears highlighted in the chart (as part of animation).
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The default transition activates PowerQff after the chart wakes up.

7 In the Breakpoints tab of the Stateflow Breakpoints and Watch Data window, clear
the breakpoint on Chart Entry. Hover the cursor over the name of the breakpoint, and

select the delete button, o . Continue simulation.

Simulation continues to the next breakpoint, the activation of the PowerOn state:

7-7



7 Simulating the Chart

fPowerOn A
FANT N R )
] il i
O temp<120] i i[On temp<150] , !
: 1 i
| ¥ :
1 I
i of 3 = E

1 ]
1 1y 1
1 [
i [temp>=120] ’:{‘ [temp=>=150] {5
{SpeedValuie 3
Eduring: airflow = in(FAN1.0On) + in(FAN2.On); |
l :
K"&’ S A y,
SWITCH l SWITCH
PowerOff
entry: airflow = 0;

Note that temp has risen to over 157 degrees. The Scope displays the temperature
pattern:
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8 To speed through the rest of the simulation, clear all breakpoints, and continue
simulation.
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Notice that FAN1 continues to cycle on and off as temp fluctuates between 119 and
120 degrees until power cycles off at 500 seconds. After power cycles off, the fans
stop running and temp begins to rise unchecked until simulation reaches stop time at
600 seconds.

The Scope captures this activity:
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Note This display should look the same as the Scope after running the prebuilt
model in “Running the Model” on page 2-9.
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9 Save Stage6Simulate, and close all other windows and dialog boxes.
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In phase 7 of this workflow, you debug the chart. In “Setting Simulation Parameters and
Breakpoints” on page 7-2, you learned how to set breakpoints and watch data. In this
chapter, you will learn how Stateflow software detects errors and provides diagnostic
assistance.
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Debugging Common Modeling Errors

In this section...

“Debugging State Inconsistencies” on page 8-2
“Debugging Data Range Violations” on page 8-4

Debugging State Inconsistencies

In this exercise, you will introduce a state inconsistency error in your chart and
troubleshoot the problem. Follow these steps:

1 Open the model Stage6Simulate — either the one you created in the previous
exercises or the supplied model for stage 6.

To open the supplied model, enter the following command at the MATLAB prompt:

addpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples'))
Stage6Simulate

Save the model as Stage7Debug in your local work folder.

Double-click Air Controller to open the chart.

Delete the default transition to FAN2.Off by selecting it and pressing the Delete
key.

Removing the default transition will cause a state inconsistency error. (Recall from
“Checking That Your Chart Conforms to Best Practices” on page 7-2 that there must
be a default transition at every level of the Stateflow hierarchy that has exclusive
[OR] decomposition.)

Your chart should look like this:
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Save the chart, and start simulation.

An error appears in the Diagnostic Viewer. The error indicates that the state FAN2
has no default paths to a substate.

Note The state number in your dialog display can differ from the one pictured above.

Locate the offending state in the Air Controller chart, by clicking the link to the state
name.

FAN2 appears highlighted in the chart:
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7 Add back the default transition to FAN2.0ff.

The default transition provides an unconditional default path to one of the substates
of FAN2.

8 Simulate the model again.

This time, simulation proceeds without any errors.

9 Save Stage7Debug, and leave the chart open for the next exercise.

Debugging Data Range Violations

In this exercise, you will introduce a data range violation in your chart and troubleshoot
the problem. To enable data range violation checking, set Simulation range checking in
the Diagnostics: Data Validity pane of the Configuration Parameters dialog box to
error.

Follow these steps:

1 In the Air Controller chart, modify the during action in the SpeedValue state by
adding 1 to the computed value, as follows:

during: airflow = in(FAN1.0n) + in(FAN2.0n) + 1;



Debugging Common Modeling Errors

Recall that in “Defining the Inputs and Outputs” on page 3-8, you set a limit range of
0 to 2 for airflow. By adding 1 to the computation, the value of airflow will
exceed the upper limit of this range when two fans are running.

Start simulation.
Simulation pauses because of an out-of-range data error:

As expected, the error occurs in the during action of SpeedValue because the value
of airflow is out of range.

To isolate the problem, double-click the last line in the error message:
Data '#439 (0:0:0)': 'airflow'

The Model Explorer opens on your desktop, allowing you to view the properties of
airflow in the right, read-only pane (read-only because simulation is running).

Note The ID number of the data that appears in the error message can vary from the
value shown.

Check the limit range for airflow:
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5 Hover your cursor over airflow to view the value.
airflow =3

This value exceeds the upper limit of 2.
Stop simulation.

7 Restore the during action to its previous code, and then restart simulation for the
model.
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The model should simulate with no errors or warnings.

See Also

Related Examples

. “Set Breakpoints to Debug Charts”
. “Watch Stateflow Data Values”






